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Send Us Your Comments

Oracle® Retail Process Orchestration and Monitoring User Guide

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document.

Your feedback is important, and helps us to best meet your needs as a user of our products.
For example:

*  Are the implementation steps correct and complete?

* Did you understand the context of the procedures?

* Did you find any errors in the information?

* Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
* Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

# Note:

Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this,
access the Online Documentation available on the Oracle Technology Network Web
site. It contains the most current Documentation Library plus all documents revised
or released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is
available on our Web site at http://www.oracle.com.
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The Oracle Retail Process Orchestration and Monitoring User Guide describes the
tracking and managing of batch jobs.

Audience

This guide is for system administrators and operations personnel, integrators and
implementation staff personnel as well as users of the module.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
https://support.oracle.com

When contacting Customer Support, please provide the following:

*  Product version and program/module name

* Functional and technical description of the problem (include business impact)

* Detailed step-by-step instructions to re-create

» Exact error message received

»  Screen shots of each step you take

Oracle Help Center (docs.oracle.com)

Oracle Retail Product documentation is available on the following website https://
docs.oracle.com/en/industries/retail/html

Comments and Suggestions

Please give us feedback about Oracle Retail Help and Guides. You can send an e-mail
to: retail-doc_us@oracle.com
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Preface

Oracle Retail Cloud Services and Business Agility

Oracle Retail (Product Name) Cloud Service is hosted in the Oracle Cloud with the security
features inherent to Oracle technology and a robust data center classification, providing
significant uptime. The Oracle Cloud team is responsible for installing, monitoring, patching,
and upgrading retail software.

Included in the service is continuous technical support, access to software feature
enhancements, hardware upgrades, and disaster recovery. The Cloud Service model helps to
free customer IT resources from the need to perform these tasks, giving retailers greater
business agility to respond to changing technologies and to perform more value-added tasks
focused on business processes and innovation.

Oracle Retail Software Cloud Service is acquired exclusively through a subscription service
(SaaS) model. This shifts funding from a capital investment in software to an operational
expense. Subscription-based pricing for retail applications offers flexibility and cost
effectiveness.



Common User Interface Controls

Oracle Retail applications, such as the Oracle Retail Process Orchestration and Monitoring
(POM) application, include some common interface options and controls that you can use
throughout the application workflow. The following sections describe these user interface
controls in more detail.

Although you may have more than one Oracle Retail application installed on your system,
each application may use many of the same interface components and abide by common
rules and constraints.

You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar. For more information on the Navigation bar, see the Navigation Area
section.

The following topics are covered in this chapter:

* Logging on to the Application
* Navigation Area

*  Table Menu Options

» Logging Out of the Application

Logging on to the Application

To log on to the application:

1. Go to the URL for the application in a web browser.

The Welcome Screen opens.

Figure 1-1 Welcome Screen

Welcome
Enter your Single Sign-On credentials below

Username:

Password:

Login

Forgot Password

ORACLE 1-1



Chapter 1
Navigation Area

2. Provide the following login information:
a. Enter your user name in the Username field.
b. Enter your password in the Password field.

3. Click Login.

Navigation Area

Tasks

ORACLE

You can quickly access the tasks of current applications and switch to other
applications from the Navigation bar.

Figure 1-2 Navigation Bar
= €=—Pin Menu

7 €&=—Tasks
- &— Notifications

1 €— Reports
o €= Settings

The following Navigation bar options are common across all the applications:

* Tasks
* Notifications
* Reports

e Settings

Oracle Retail applications support a variety of navigational tools and methods that
allow you to move efficiently between application pages. Information on how to use
and manage each of the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to
accomplish a business process or procedure. For example, tasks can be defined for
common multi-step procedures or processes so that you can quickly step through
tasks. By navigating sequentially to the pages outlined in the task, you are assisted in
stepping through the business process or activity.

Your Tasks list appears on the top left side of the home page. All of the tasks to which
you have access are listed on the Tasks window. You can either click on the specific
task name to open, or use the Task Search component to search for a Task that you
want to open.

1-2
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To begin working with a task, choose the application feature or process from the list.

# Note:

Your task menu may appear slightly different, depending on your retail application.

Figure 1-3 Tasks Menu

Tasks

o~

L Search for a task

Batch Monitoring
System Configuration
Batch Administration
Scheduler Administration
Schedule Maintenance

AMS Utilities

Notifications

The Notifications option brings events within the application to your attention.

See the following examples:

ORACLE' 1-3
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Figure 1-4 Notifications

Motifications

D\ Search for a notification

Filters v Group By (1 v
System Error

® System Error

RSP i External Status Update...
571720 10-10:08 AM
POAM_ADMIN

@ System Error

MERCH :: Unable to publish ...
5/20/20 24257 PM
POAM_ADMIN

Batch execution error

@ Batch execution error

MERCH :: Job SALESUPLOA...
5/20/20 32814 PM
POAM_ADMIN w

See All

Notification Badge

ORACLE

The Notification Badge displays the number of unread notifications for the user in the

sidebar menu. The Notification Badge displays '99+', when there are more than 99
notifications.

The notification count is periodically refreshed at regular intervals. This interval is
determined by a system-configured value.

1-4



Chapter 1
Navigation Area

Figure 1-5 Notification Badge

Notification Sidebar

ORACLE

When you click the Notification icon, a Natifications Sidebar is shown that displays the most
recent set of unread natifications in the natifications screen (depending on the filter set).

Figure 1-6 Notifications Sidebar

Notiﬁcationsr- Search Bar

‘ Q. Search for a notification ‘ P TDgglE View

Filters ¥ | Group By (1 H GFDUpiﬂg Panel
]

Systery Error

Filtering Panel
System Error

RSP = External Status Update...H Search Results Panel

5/21/20 10:10:08 AM
POAM_ADMIN

@® System Error

MERCH :: Unable to publish ...
5/20/20 24257 PM
POAM_ADMIN

Batch execution error

@ Batch execution error

MERCH :: Job SALESUPLOA...
5/20/20 3:28:14 PM

POAM_ADMIN W
See Al & All Notifications Tab
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Each component of the Notifications Sidebar is discussed in detail in the following
sections.

Search Bar

A search bar at the top of the panel allows for searching through notifications. The
search bar has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the
Notification results to be displayed either in a flat or grouped view.

Figure 1-7 Search Bar

~,,  Exter ‘

RSP :: External 5tatus |
Update failed for a job
with JOB_RUN_ID =
2839408 under
SCHEDULE = RSP. See

late...
log for further details.

RSP = External Status
W System Error

Filtering Panel

The Filtering Panel allows you to filter notifications based on the creation Time Period,
Type and Severity.

The values for the Time Period and Severity components are pre-seeded constants.
The Type drop-down lists all the natification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the
Results Panel.

ORACLE 1-6
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Figure 1-8 Filtering Panel

Filters ~  Group By (1 v
Time Period

Any v
Type
Severity
Reset Cancel Apply

Grouping Panel

This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.

Figure 1-9 Grouping Panel

Filters ¥  Group By 1 -
Group By

Type v
Then By

Mo Selection v
Reset Cancel Apply

Results Panel - List View

When no selection is made in the Grouping panel, the Results Panel displays notifications in
a list format.

The image below shows a simple search without any filtering or grouping.

ORACLE 1-7
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Figure 1-10 Results Panel - List View

Filters (1 % 1
@ ystem Er‘l‘nr‘bﬂﬂ~|I 2
o ———

520720 3:28:14 PM
POAM_ADMIN

Indicates that one filter was applied.
Notification Type - A description of the Type is displayed.
Read/Unread - A blue icon is shown next to the notification if it is unread.

Notification Severity - A label indicating the severity of the notification is shown.

o w0 Db P

Description - The description associated with the notification. If the notification was
designed to launch into a relevant flow, then this is displayed as a link. Otherwise,
the description is rendered as plain text.

6. Creation Time - A timestamp that shows the date and time at which the notification
was created.

7. User name - Creator of the notification.

Results Panel - Grouped View

Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results panel, when the
Group By drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.

ORACLE 1-8
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Figure 1-11 Results Panel - Grouped View

Filters (1 v Group By (1 P 1
]
S}rﬂem Error % 2

® System Error

R5P = External Status Update...
5/21/20 10-10n08 AM
POAM_ADMIN

® System Error
MERCH = Unable to publish ...

5,20/ 20 24257 PM
POAM_ADMIN

Batch execution error

B Batrh avarmkian areae

1. Indicates the Group-By drop-down is selected on the Grouping Panel.

2. The value of the Group-By attribute. In this example, the results were grouped by
Notification Type. Hence the Notification Type is shown as the header of the group.

For each group, three notifications are shown followed by a 'See More' link. When you click
this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View

ORACLE

Notifications are summarized as shown in this example, when both the Group By and the
Then By drop-downs in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping panel. For each subgroup, a count of the notifications within that
subgroup, grouped by severity is displayed.

The example here depicts a grouping by department, then by class.
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Figure 1-12 Results Panel - Summarized View

Filters v Group By (2 H 1
]

Rsp_ 2

UEIIEIEUEDﬁ 3

1 Critical
£/21/20 10-10H0E AM

MERCH

02/16/2020 g50 €&— 4

105 Critical IERN ] 5
/20,20 32814 PM

_6

merch

05/14/2020 1
/14720 24163 AM

05/11/2020 2

Indicates that both options on the Grouping Panel have been selected.
First level of grouping is by Schedule Name. Here the first type shown is 'RSP".
The subgroup within Type 'RSP'. In this example, this is the Business Date.

The number of notifications within that combination of Group and Subgroup.

g @ b P

A grouping by severity of all notifications within that combination of Group and
Subgroup.

6. The timestamp of the most recent notification of that combination of Group and
Subgroup.

Notifications Tab

The Notifications tab opens when you click the 'See All' link at the bottom of the
Notifications side panel.

ORACLE 1-10
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Figure 1-13

Notifications X

Notifications Tab

[ All Notifications | | © All Unread | | @ Critical
817
Read Unread 123 120 0
694 123
Actions ¥ View v <& & Detach
Severity Status ~ Description Type
[ ] RSP :: External Status Update failed for a job with JOB_RI System Error
RSP :: Job ORASE_END_END_JOB is classified as long run Long running Job
RSP :; External Status Update failed for a job with JOB_RI System Error
RSP :: External Status Update failed for a job with JOB_RI System Error
RSP :: External Status Update failed for a job with JOB_RI System Error
RSP :: External Status Update failed for a job with JOB_R! System Error
RSP :; External Status Update failed for a job with JOB_RI System Error
(m RSP :: Fxternal Status Undate failed for a inb with IOR Rl Svstern Frrar

Important

Alerts

Normal

Recipients
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN

POAM ANMIN

Creation Date
5/21/20 10:10:08 AM
5/21/20 10:08:46 AM
5/21/20 10:07:53 AM
5/21/20 10:07:52 AM
5/21/20 10:07:52 AM
5/21/20 10:07:52 AM
5/21/20 10:07:52 AM

5/21/20 10:07:51 AM

Chapter 1

Navigation Area

Created By
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN
POAM_ADMIN

POAM ANMIN

Last
52120
5/21/2
5/21/2
5/21/2
5/21/2
5/21/z
5/21/2

5217
>

This tab lists all the notifications for the logged-in user, regardless of whether they are in
Read or Unread status. Information tiles display a break-up of the total notifications by
severity. Clicking these tiles refreshes the table below to display only those notifications that
are relevant to that tile.

You can perform the following operations from this tab.

button.

Refresh “_* - This refreshes the list of notifications in the table.

Delete * - The table allows for multiple selection and hence multiple notifications can be
deleted at a time. Use the row header to select the row.

Mark as Read - Multiple Unread Notifications can be marked as Read by clicking this

» Mark as Unread - Multiple Read Notifications can be marked as Unread by clicking this

button.

* Reassign Notifications !-'I- - Notifications can be reassigned to individual recipients or a
group by clicking the Reassign Notifications icon. On selecting a row in the All
Notifications table, and clicking the icon, the reassign notification popup is displayed. The
Type is set to Reassigned by default, and the Severity and Description are pre-populated
from the selected row; you can then change any of these values and assign the
notification to one or more recipients.

1-11
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Figure 1-14 Reassign Notification

Reassign Notification X
Severity Type

Critical v Reassigned v
Description

R5P = Failure during Phase II - Creating a Schedule Instance in the DB,
while creating a RSP schedule instance, due to PL-5QL Execution failed

Choose Recipients Selected

Coarrh for recioiant

[+1]

)
[

Cancel OK

The All Notifications table displays the following columns:

Severity - A colored label indicating the Notification Severity.

Status - If the status is unread, an icon ® is shown. Otherwise it is blank.
Description - The description of the notification itself.

Type- The description of the Notification Type for the notification.

Alerts -

Recipients - In case of individual naotifications, this column contains the user ID of
the user to whom the notification is assigned. When the notification is assigned to
multiple users, it displays the text 'Multiple' and enables a context popup which
lists all the recipients. This field is empty when the notification is assigned to a
group associated with a type.

Creation Date - Timestamp showing the date and time of creation.
Created By - User ID of the user who created the notification.

Last Updated Date - Timestamp showing the date and time when the last update
was made.

Last Updated By - User ID of the user who last updated the notification.

Application ID - Unique identifier that identifies the application. Not visible by
default.

1-12
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» Department - The Department associated with the notification. Not visible by default.
» Class - The Class associated with the notification. Not visible by default.

* Subclass - The Subclass associated with the notification. Not visible by default.

» Location - The Location associated with the notification. Not visible by default.

»  Supplier - The Supplier associated with the notification. Not visible by default.

» Performance - The Performance value associated with the notification. Not visible by
default.

» Brand - The Brand associated with the notification. Not visible by default.
* Rollup Count - The Rollup Count associated with the notification. Not visible by default.

» Additional Information - Refers to the Additional Information attribute associated with the
notification. Not visible by default.

The functionality of Reports works similar to the Tasks menu.

The Settings icon on the Navigation Bar displays the application's Settings menu when
clicked. This menu differs per application and for POM, it contains the Application Properties
menu item.

Settings

Application Properties

Application Properties

ORACLE

Application properties are key-value pairs of parameters and configuration settings used by
POM to operate efficiently and to control the application's behavior. For instance, a property
may exist to turn off certain features within the application or to set limits on different event
timings. This screen is restricted to administrators as application inner-working expertise is
needed for understanding the impact of each property.

Application properties are grouped by Deploy Names, so one needs to be provided for the
search to return results.

Each property is provided with a default value in case a property value is not set. Each is also
provided with a Deployment Restart attribute, which indicates whether a server restart is
needed for a new value to take effect.

1-13
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Table Menu Options

The Application Properties page provides the following features:

e Search for application properties

*  Filter application properties

e Sort application properties

» Update the value of an application property using the Edit Property dialog shown
below:
Edit Property x

Table Menu Options

< Note:

Figure 1-15, Figure 1-16 are representations and may be different for every
window/table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For
more information on these options, see the sections Action Menu and Icons and View

Menu.

Action Menu and Icons

The Actions menu provides the option to take different actions related to entries in the
table. Depending on the nature of the table, these actions can be add, view, delete or
edit table rows, create by moving to a new screen or export the table contents to the
spreadsheet. Alternatively these actions can also be performed by using the icon

ORACLE
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buttons on the table toolbar. For more information on the icon/buttons, see the Screen Level
Action - Icons and Buttons.

In some tables, it may also contain some table specific actions.

Figure 1-15 Action Menu and Icons

¥ g Detach

r
m
=
.1
m

Process Mame

Table 1-1 Actions Menullcons and Descriptions

_________________________________________________________________________|
Actions Menullcon Description

Refresh and Refresh icon 2% Select Actions > Refresh or the Refresh icon “_* to update the
records in the table.
Filter icon T Select the Filter icon ¥ to open fields that will filter the results.

Use the filter fields to only show the rows matching or containing
the entered information.

Detach and Detach Icon &/ Select Actions > Detach or the Detach icon & to open the table
in a separate window.

View Menu

The View menu provides the options for managing the table columns and sorting and filtering
the table data.

In some tables you have the option to choose a saved custom view, which is an arrangement
of columns different from the default view of the table.

Figure 1-16 View Menu
Manage Columns
Detach

Sort

«  Query by Example

ORACLE 1-15
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Table 1-2 View Menullcons and Descriptions

_______________________________________________________________________|
View Menu List Description

Manage Columns You can show or hide columns and change the order of the
columns by selecting View > Manage Columns.

This View menu option is only available for tables with a
large number of columns.

Note that the changes performed on the Manage Columns
popup are persisted on the browser's cache and therefore
are lost when the cache is cleared or when the browser is
changed. Persistence of column preferences will be
switched to the database in a future release, thereby
preserving those preferences even when browser cache is
cleared or when the browser is changed.

Detach and Detach icon & You can view the tables in the application in a separate
window by selecting View > Detach or by using the Detach

icon 5.
Query by Example You can filter the items by one or multiple column values by
selecting View > Query by Example.

Screen Level Action - Icons and Buttons

The screen level actions display the icons and buttons.

Table 1-3 Screen Level Action - Icons/Buttons and Description

Icons/Buttons Description

Close window Click the * icon to close the window.

Application Help and About Application Links

Use the Help list menu on the top right of the window, to open tabs for Application Help
or About Application.

Figure 1-17 Application Help Menu

POAM_MONITOR - -

Application Help

About Application

Logging Out of the Application

Use the User list menu on the top right of the window, to log out of the application.

ORACLE 1-16
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Figure 1-18 Logging Out of the Application

Logout

ORACLE 117



Process Orchestration and Monitoring

The Process Orchestration and Monitoring (POM) application is a user interface for
scheduling, tracking and managing batch jobs.

Process Orchestration and Monitoring has the following tabs:
e Batch Monitoring

*  System Configuration

*  Batch Administration

e Scheduler Administration

* Schedule Maintenance

*  AMS Utilities

Batch Monitoring

ORACLE

Batch Monitoring

The Batch Monitoring tab provides a runtime view of the statuses and dependencies with
regard to the different batch cycles for the selected business day.

Select Batch Monitoring in the Navigation Area to open the Batch Monitoring tab.

The application will by default open for a business date where at least one schedule is active.

If none found, it will open for the most recent business date where at least one schedule is
active.

Figure 2-1 Batch Monitoring
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The header displays information about the batches displayed in the Batch Monitoring
tab. You can also use the header selection to choose which schedule batches to
display.

Figure 2-2 Batch Monitoring Header

Batch Monitoring X

Business Date 07/31/20 =] % 1

g O RDE 19.1.001 | | @ RI19.1.001 @ RSP 19.0.0 ;
Schedule Import In Progress Nightly:  Completed (739/740) Nightly:  No Jobs Scheduled
Standalone: Completed (131/132) Recurring:  12th Disabled ©/0) H 4 2 3
Standalone: No Jobs Scheduled 7 8
Last Schedule Date: 08/01/20 Last Schedule Date: 08/05/20 \‘ \
Nightly = Recurring F 5 5 H % Upgrade Available Close Schedule Restart Schedule

6 9

l !

i+ View Upgrades Download Cyde Summary

O -E1CRT LIV | ost Schedule Instance: 07/26,/20

1. Business Date - Displays the business date for the oldest schedules displayed in
Batch Monitoring.

Use this field to select the oldest schedule displayed in Batch Monitoring.

2. Environment Status Icon - Click this icon to display a panel at the right side of
the screen showing the status of the Scheduler, Execution Engine and the
environments. The user can also manage the information displayed. See Status
for more information.

3. Activity Feed - Click this icon to display a panel at the right side of the screen
containing activities performed by the system and by the user.

4. Environments - Displays information about each environment integrated with
Process Orchestration and Monitoring.

Select one of these panels to display information about that environment’s batch
processes.
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Monitoring Cycle - Displays the monitoring cycle of the batches displayed.

Select a monitoring cycle to see the batches scheduled for that cycle. The following
monitoring cycles are available:

*  Nightly
* Recurring
e Standalone

Upgrade Available - Use this button to navigate to the Schedule Maintenance screen for
the option to upgrade the batch schedule to a new version. This button only appears
when there is a new version of the schedule available and there is no upgrade in
progress or in error. When an upgrade is in progress or in error, the button caption
changes to View Upgrades which also navigates the user to the Schedule Maintenance
screen.

Close Schedule - Use this button to close the schedule. This button only appears for
Active schedules.

Restart Schedule - Use this button to restart the schedule. This button only appears for
Active schedules.

Download Cycle Summary - Use this button to download a summary for the currently
selected business day for the selected schedule. Once clicked, the Download Cycle
Summary dialog provides the user options to select the cycle and format. This button only
appears for Completed schedules.

Create Schedule - Use this button to create a new Scheduler Day. This button only
appears when a schedule tile is selected for which there is no open Scheduler Day. Click
this button to create a new Scheduler Day for the selected schedule for the business date
following the last schedule instance.

Each schedule tile displays information for a batch schedule that POM is responsible for
running.

Select a tile to display the list of batch processes for that schedule.

Each panel displays the following information:

Figure 2-3 Schedule Tile

1
2\.4 4 : J‘
P MERCH 19.0.001
4=3nNightly:  Completed (380/380)

ORACLE

Recurring: 24th Completed {107/1...
Standalone: Completed (228/228)

Last Schedule Date: 02/17/20
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< Note:

A red tile with a red cloud indicates that a new schedule version upgrade
has failed. Navigate to the Schedule Maintenance screen by clicking on
the View Upgrades button to address the failure.

A blue spinner in the top left of the tile (2) indicates that the schedule is
in the process of being upgraded to a new version. The user can
navigate to the Schedule Maintenance screen by clicking on the View
Upgrades button to check the progress of the upgrade.

When a schedule is being upgraded or when the schedule upgrade has
failed, the user is prevented from most activities on the Batch Monitoring
and on the Batch Administration screen.

bled while

| ) Somefestures are dis schedule is being imported |

pled while 3 schedule is in 3 failed state

| ) Somefesturss aredis

An amber warning circle in the top left of the tile (2) indicates that the
schedule is set to run in safe mode. This means that the batch schedule
will simulate a complete run but without the jobs actually executing on
the application server. Aside from the amber warning circle displayed in
the top left of the tile, a ‘Safe Mode is currently enabled’ message is
displayed in the area right below the tile area.

Safe Mode is currently enabled

An amber tile indicates that there is no instance of the schedule for the
selected business date.

Schedule name and Version - Displays the abbreviation of the application or
application group and the software version.

Run Status - Displays the status of the batch processes.

Completed (green check mark icon)
Active (green target icon)

Error (red X icon)

No activity (amber triangle icon)
Suspended (pause icon)

Safe mode (Amber circle icon with a warning icon inside of it)

Schedule Upgrade - A grey cloud indicates that a newer version of the batch
schedule is available.

A red cloud indicates that schedule upgrade has failed. Navigate to the Schedule
Maintenance screen to address the failure.

A blue spinner indicates that a schedule upgrade is in progress.
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Monitoring Cycles and Statuses - Displays the number of completed and total
processes for each monitoring cycle.

Last Schedule Date - Indicates the last date on which the batch processes were
configured.

Batch Jobs Header

The batch jobs header displays the following information:

Figure 2-4 Batch Jobs Header

Run Status Chart

The run status chart shows a chart summary of the status of the different batches (including
the number of batch jobs with that status) that are included in the selected cycle for the
selected schedule. The possible statuses are:

Loaded - Jobs are in loaded state when the scheduler day is first created.

Pending - Job is waiting to run.

Completed - Job ran successfully on the system.

Error - A failure occurred due to an issue in the environment or the job's application.
Held - An administrator placed the job on hold.

Skipped - An administrator has skipped the running of the job so the remaining jobs in the
cycle can proceed.

Running - Job is currently running on the system.

Long Running - The job's run time has exceeded a threshold. This threshold is calculated
by multiplying the job's average run time and the Long Run Average Time Multiplier
defined on the schedule Settings section of the System Configuration screen.

Disabled - Job was disabled by an administrator on the Batch Administration screen.
System Held - Job was placed on hold by the system due to a lack of resources to run it.
Skipped on Error - Job was preconfigured to be skipped on a failure.

Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly Cycle,
External Dependency and Inter-Schedule Predecessor Jobs).

Completed Batch Job Statistics

For completed batch jobs, the batch job header shows the following information:

ORACLE

Run Start
Run End

Total Duration

2-5



Chapter 2
Batch Monitoring

e Average Duration

Active Batch Job Statistics

< Note:

Active Batch Job Statistics are not yet implemented. They will be
implemented in a future version of POM.

For active batch jobs, the batch job header shows the following information:

» Estimated Completion Time
» Estimated Time Remaining
* Total Duration

* Average Duration

¢ Run Start

Batch Information

The batch information area displays the following information about the batch process
results:

Execution Requests - Displays the number of completed executions and the total
number of execution requests. Click to open the Execution Requests Window.

Agent Job Requests - Displays the number of completed and total number of Agent
job requests. Click to open the Agent Job Requests Window for the schedule and
cycle selected.

Scheduler Tasks - Displays all tasks scheduled to run during the current scheduler
day. Click to open the Scheduler Tasks window.

External Dependencies - Displays the number of successful and total number of
external dependencies. Click to open the Batch Cycle Details Screen.

Inter-Schedule Dependencies - Displays the number of successful and total number
of inter-schedule dependencies. Click to open the Batch Cycle Details Screen.

Callbacks - Displays the number of successful and total number of callbacks. Click to
open the Batch Cycle Details Screen.

Schedule Links - Displays the number of successful and total number of schedule
links. Click to open the Batch Cycle Details Screen.

Execution Requests Window

The Execution Requests window displays information about execution requests for a
batch.

Click Done or the close window icon * to close the window.
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Figure 2-5 Execution Requests Window

Execution Requests for MERCH Nightly

Execution Requests

Actions ¥ View =

Filter Filter =
ExecutionID  Status

316 © Loaded

<

Execution ID 316 Details

Actions ¥ View =

Filter Filter

Job Run ID Status

410082 © Loaded
410084 © Loaded
410085 © Loaded
410086 © Loaded
410087 © Loaded
410088 © Loaded
410089 © Loaded
210090 0 | oaded
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ALC_SIZE_PROFILE_TRANSFORM_LOAD_PROCE...

ALC_SNAP_SHOT_ALLOC_IN_PROCESS

ALC_SNAP_SHOT_ALLOC_OUT_PROCESS

ALC_SNAP_SHOT_CROSS_LINK_PROCESS

ALC_SNAP_SHOT_CUST_ORD_PROCESS

ALC_SNAP_SHOT_ON_ORD_PROCESS

ALC_SNAP_SHOT_SOH_PROCESS

Al OCRT PROCFSS

X
Filter Filter Filter Filter '
Completed Pending Skipped Failed
0 396 3 1
>
Fitter Filte
Job Execution Last Update
D
a
v
>
Done

This section displays the following information about each execution request in the batch

process:
* Execution ID
o  Status

* Cycle

*  Flow

Scheduler Day
Total Jobs
Completed
Pending
Skipped

Failed

System Held
Submitted

See Table Menu Options in the Common User Interface Controls for information about the
options available for this section.

ORACLE
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Execution Details

This section displays the following information about each job run by the execution
request:

e JobRunID

»  Status

e Job Name

* Process Name

* Job Execution ID
e Last Update

e First Job

e Error Info

See Table Menu Options in the Common User Interface Controls for information about
the options available in this section.

Agent Job Requests Window

The Agent Job Requests window displays information about batch requests submitted
to the POM Agent. The agent is the component of POM usually deployed on the
application server where the batch jobs actually execute.

Click Done or the close window icon () to close the window.

Figure 2-6 Agent Job Requests Window

UUUUUUUU
<<<<<<<

Agent Job Requests

ORACLE

This section displays the following information about each Agent job request in the
batch process:

e Status - Possible values are Complete, Running, Error, Canceled and Loaded
* Request ID - Agent request ID

e Type - Possible values are EXEC (shell script based job) or RI/RASE/RPAS/BDI
which are all values for service based jobs

e Job - job name
e Process - Process name

e Payload - Service payload in case the type corresponds to a service based job
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Info - Error Information in case the request is in Error status

Agent Id - The identifier of the Agent which Initiates the job execution request
Application Name

Create Date

Start Time

End Time

Last Update Time

Execution Request Id

Job Run Id

Submitted

See Table Menu Options in the Common User Interface Controls for information about the
options available in this section.

Scheduler Tasks

The Scheduler Tasks window displays information about tasks that are scheduled to run
during the current scheduler day. See the Scheduler Administration section of this chapter.

ORACLE

When the new scheduler day is created every day (at the end of the Nightly batch run), it
creates the scheduler tasks according to the way they are set up in the Scheduler
Administration screen.

Figure 2-7 Nightly Scheduler Task Window

2-9



Figure 2-8 Recurring Scheduler Tasks Window
MERCH Hourly_Cycle 1 Scheduler Tasks

Actigns iew n * Datach Stap  Renlow

Actiana = Yiew = n * Dirtach

Hatus Stard Tima

Click Done or the close window icon () to close the window.
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iy - Ireiks Slandard T

The Scheduler Tasks window for the Nightly and Recurring cycles display the same
task attributes listed below. The difference is that there is only one Nightly task for a
scheduler day whereas there could be multiple Recurring flows running throughout the

day.

Nightly/Recurring Scheduler Tasks

ORACLE

This section displays the following information about each Nightly/Recurring Scheduler

task:

e TaskID

* Enabled - Switch to enable or disable the execution of the task

e Status - Possible values are: Enabled, Disabled, Completed, Skipped On Delay,

Scheduled, Error, or Cancelled
e Flow Name - Nightly or recurring flow name
e Schedule Date
e Schedule Time

e Time Zone

# Note:

When the New Scheduler Day is created, if the start time for a certain task
has elapsed, the task will be scheduled for the next day. The Next Schedule
Run column will show the next time the task will execute.
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See Table Menu Options in Common User Interface Controls for information about the
options available for this section.

Task Executions

ORACLE

Task Executions
This section displays the following information about each task executions:

e  Status - Possible values are: Completed, Error
e  Start Time

e Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing error details.

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.

The user can edit the Nightly or Recurring tasks to change the time they run for the day.
Permanent changes need to be entered in the Scheduler Administration screen.

¢ Note:

If the user makes a change to the time, he or she needs to click the Run action to
schedule the task.

Also, for the task to be editable, it must be in a state other than Scheduled. If it is in
a Scheduled state, the user can click the stop action, which puts the task in a
Cancelled state and it is therefore editable.

Edit Task ACTIVITY_SCHED_PURGE_CYCLE =
Enabled @]
Schedule Date  02/01/21 [
Schedule Time 12:11PM -

Cancel Ol

It is alternatively possible for the user to circumvent the steps mentioned above and
click on Run Now if they intend to schedule the task for immediate execution.
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Figure 2-9 Standalone Scheduler Tasks Window

Click Done or the close window icon () to close the window.

Standalone Scheduler Tasks

ORACLE

This section displays the following information about each Standalone Scheduler task:
Task ID
Enabled - Switch to enable or disable the execution of the task.

Status - Possible values are: Enabled, Disabled, Completed, Skipped On Delay,
Scheduled, Error, Cancelled.

Process Name
Frequency - Daily or Every x minutes.

Limit Occurrences -If this field has a value, the process will run every x minutes for y
occurrences.

Prevent Start During Nightly - Indicates that the process should not start running
when Nightly is in progress. If the process starts running before Nightly start, it will
continue running even if the run extends into the Nightly run.

Schedule Date

Schedule Time

Next Scheduled Run - Displays the date and time the next run will occur.
Time Zone

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.

The user can edit a Standalone task to change any of the fields in the window below.
Edits are effective just for the day's run. Permanent changes must be entered in the
Scheduler Administration screen.
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Edit Task REPL_INDCTN_PURGE_PROCESS_ADHOC x
Enabled @)
Purge Replenish Records
Description
Frequency Minutes * |15 v o[ A
Limit occurrences 1 &
Schedule Time  12:00 AM G) (UTC+05:30) Calcutta - India Standard Time v

Prevent start during nightly @)

Cancel Ok

" Note:

If the time is left blank for a standalone task, it will execute immediately upon
clicking OKk.

When the New Scheduler Day is created, if the start time for a certain task has
elapsed, the task will be scheduled for the next day. The Next Schedule Run
column will show the next time the task will execute.

Task Executions

This section displays the following information about each task execution:

*  Execution ID
*  Status - Possible values are: Completed, Error
e Start Time

* Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing the error details.

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.
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Batch Cycle Details Screen

Batch Cycle Details

RI Nightly

External Dependencies

Status Source Job Target Job.

Pending ZIP_FILE WAIT_IOB Testing Job

Inter-Schedule Dependencies

Schedule Links

Callbacks

The Batch Cycle Details screen displays the following sections:

Header
The header displays the following information about the batch cycle:

e Run Status Chart

Completed Batch Job Statistics
Completed Batch Job Statistics
For completed batch jobs, the batch job header shows the following information:

e Run Start
e RunEnd
e Total Duration

e Average Duration

Active Batch Job Statistics

For active batch jobs, the batch job header shows the following information:

< Note:

Active Batch Job Statistics are not yet implemented. They will be
implemented in a future version of POM.

e Estimated Completion Time
e Estimated Time Remaining

e Total Duration
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e Average Duration

 Run Start

External Dependencies

4 External Dependencies

actions v Viewy [ |V ‘ | Detach
External External
External Job DependencyType E:;i:;' :3::-1 Name Dependency Dependency
Status Enabled
Wh_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING 7 j
WweeklySales_Tx_ProcessFlow_From_RMS#end EXTERNAL PENDING ¥
WeeklySales_Tx_FileCreator_ProcessFlow_From_RMS#end EXTERNAL PENDING P
Uda_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING 3
UdaValues_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING 7
UdaltemLov_Fnd_ProcessFlow_From_RMS#end EXTERMAL PENDING P
UdaAnduUdaValues_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING 73
UdaAndUdaValues_Fnd_FileCreator_ProcessFlow_From_RMS#end EXTERNAL PENDING ¥

The External Dependencies section lists all the external batch job dependencies for the entire
current Schedule. These dependencies are only shown if the system level external
dependencies indicator is turned on. An external dependency is usually a dependency on a
customer's internal process. This dependency is released once the customer calls an
endpoint into POM for a specific POM job.

The following information is displayed for each external dependency:
»  Status

e Source Job - Click to open the job in the Batch Job Details screen. The source job is a
job in the current schedule which is dependent on the external (target) job.

» Target Job - The job that, when complete, will release the dependency which the source
job is waiting on.

- A Disable/Enable button to disable or enable the dependency.

Inter-Schedule Dependencies

ORACLE

Inter-Schedule Dependencies
Status Source Job Target Job Target Process Target Schedule

Pending ZIP_FILE WAIT_JOB ALCDETAILSSDE_JOB ALCDETAILSSDE_PROCESS RDE Disable

The Inter-Schedule Dependencies section lists all the inter-schedule batch job dependencies
for the entire current Schedule. These dependencies are only show if the system level inter-
schedule dependencies indicator is turned on. An inter-schedule dependency links the
current schedule and a target schedule where a job in the target schedule is dependent on
the completion of a job in the current schedule.

The following information is displayed for each inter-schedule dependency:

e  Status

e Source Job - Click to open the job in the Batch Job Details screen.
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* Target Job - Click to open the job in the Batch Job Details screen. Target job is
dependent on the source job.

» Target Process - Process containing the target job.
» Target Schedule - Schedule containing the target process/job.

* A Disable/lEnable button to disable or enable the dependency.

Schedule Links

Callbacks

ORACLE

Schedule Links

A Schedule Link links the current schedule and a target schedule where the current
schedule does not start until the completion of a job in the target schedule.

The following information is displayed for each schedule link:

e  Status

e Source Job - Click to open the job in the Batch Job Details screen. The job in the
current schedule which starts the current batch when the Target Job completes.

e Target Job - Click to open the job in the Batch Job Details screen. The job in the
Target Schedule which when completes fulfills the dependency for the Source Job
in the current schedule.

e Target Process - The process which the Target job belongs to. - The schedule
whose job is a dependency for the job in the current schedule.

e Info - Shows information regarding error if failed or skipped.
e Target Schedule

e If it was not successful, a Retry button to retry the schedule link.

Callbacks

Status

3 Failec W_INT_ORG_DH_RTL_TMP_JOB OAD_DIM_INITIAL_ADHOC baylozd o Retry

© Faled W_RTL_ORG_RECLASS_TMP_JOB GAD_DIM_INITIAL_ADHOC Paylosd fo Retry

The Callbacks section lists all the external status update request and response
callbacks based on the External Status Update mode set in the External System
Configuration screen.

The following information is displayed for each callback:

e  Status

* Job - Click to open the job in the Batch Job Details screen.
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Process - Process containing the job.

Date of callback

A Payload link to display the Payload Window for the callback.

An Info link to display the Info Window describing the callback response.

If the callback was not successful, a Retry button to retry the callback.

RPASCE Nightly Batch Jobs

Actions ~

Status

O Losaca
O Losaca
O Loaded
O Loaded
O Losded
O Losded
0 Losaca
O Losaca
O Losaca
O Losaca
O Losaca
O Losaca
O Losded
O Loaded

oo Aopication L R —— PO oy o Desap StotTime tnaTine
MFP_BATCH_AGG_D_IOB MFP sal Reas MFP_BATCH_AGG_PROCESS O Loaded A
MFP_BATCH_AGG_END_JOB MFP BEC MFP_BATCH_AGG_PROCESS Q Loaded
MFPWB BUILD_START_IOB wirp #550Bt..  EIEC MFPWE BUILD_PROCESS © Loaded MFP Workbook Buid/Refresn StartJob
MFP_WE BUILD_END._JOB wre solution=... BXEC MFP_WB BUILD_PROCESS O Loaded MFP Workbook Buld/Refresh End Job
MFPWE_BUILD_D_IOB wrp ssyOpt.. | BIEC MFP_WE BUILD_PROCESS O Losded MEP Workbaok BuildRefresh Daily Job
Mr s5s0pt.. | BEC MFP_PRE_EXP_PROCESS O Losded MEP e Exports Start Job
wire sspopt.. | BEC MFP_PRE_EXP_PROCESS O Losaca MR e Exports to ROX Daily Job
MFP #5y5Opt... | EXEC MFP_PRE_EXP_PROCESS O Losded MEP Pre Exports to Files Daily Job
MFP #5y5Opt... | EXEC MFP_PRE_EXP_PROCESS O Losded MFP pre
MFP solution=. RPAS MFP_PRE_DATA_IMP_PROCESS O Losded MFP pre
MFP #5y50pt.. | EXEC MFP_PRE_DATA IMP_PROCESS © Loaded MFP Pre x
MFP #SpsOpt... | EXEC MFP_PRE_DATA_IMP_PROCESS © Loaded MFP Pre Data Imports from Files Daily Job
wrp o5 #5ys0pt... | BIEC MFP_PRE_DATA IMP_PROCESS O Losded MEP Pre Data Imports End Job
MFP_POST_EXP_START_IOB wrp 0571021 01:43:49 COT s50pt.. BEC MFP_POST_EXP_PROCESS O Loaded MEPPost Exports Stat Job

The Batch Jobs section lists all the batch jobs for the selected schedule and the selected
cycle. The table displays the following information:

Status

Loaded - Jobs are in loaded state when the scheduler day is first created.

Pending - Job is waiting to run.

Completed - Job ran successfully on the system.

Error - A failure occurred due to an issue in the environment or the job's application.
Held - An administrator placed the job on hold.

Skipped - An administrator has skipped the running of the job so the remaining jobs
in the cycle can proceed.

Running - Job is currently running on the system.

Long Running - The job's run time has exceeded a threshold. This threshold is
calculated by multiplying the job's average run time and the Long Run Average Time
Multiplier defined on the schedule Settings section of the System Configuration
screen.

Disabled - Job was disabled by an administrator on the Batch Administration screen.

System Held - Job was placed on hold by the system due to a lack of resources to
run it.

Skipped on Error - Job was preconfigured to be skipped on a failure.

Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly
Cycle, External Dependency and Inter-Schedule Predecessor Jobs).

Job - Click to open the job in the Batch Job Details screen.

Application
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e Last Update
* Parameter

» Job Type - Depending on the value, determines if a job is service based or shell
script based.

e Process Name
*  Process Status

* Log - When the job is in error, this field will display a down-arrow icon which when
clicked will display the content of the log.

» Job Description

e Start Time
e End Time
e Duration

* Average Run Time

* Average Historical Run Time
*  Number of Runs

»  Error Source

*  Waiting

*  Waiting Reasons

Action Menu and Icons

See Action Menu and Icons for common actions that can be performed through the
Action menu and the icons. You can also perform the following actions:

Table 2-1 Batch Jobs - Actions Menul/lcons and Description
|

Actions Menullcons Description

Hold Use the Actions > Hold or the Hold button to put the
process on hold.

Skip Use the Actions > Skip or the Skip button to skip the
process.

Run Use the Actions > Run or the Run button to run the process
immediately.

Rerun Use the Actions > Rerun or the Rerun button to run the job
again.
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Table 2-1 (Cont.) Batch Jobs - Actions Menul/lcons and Description

Actions Menullcons

Description

Kill

Edit Parameters

Use the Action>Kill or the Kill button to stop the execution
of the job.

The job needs to be running for this action to be enabled.
When the Kill command is enacted on the screen one of two
confirmation messages opens depending on whether a
cleanup script is associated with the job being killed.

If a cleanup script is associated with the job, the
confirmation message presented is “a cleanup will be
performed after this job is terminated. It is advisable to wait
a few minutes after termination before proceeding with the
remaining batch schedule” This is because it may take a
minute or so for the cleanup to complete.

If a cleanup script is not associated with the job, the user is
cautioned to make sure he or she is sure about proceeding
without a cleanup script.

That maybe be acceptable, as not all jobs require cleanup
when terminated. The confirmation message in this case is
“there is no post termination cleanup script associated with
this job. the job will be terminated but not post cleanup will
be performed. This may or may not be ok for this job. Check
with Oracle Support if this is a concern.

Use the Actions > Edit Parameters or the Edit Parameters
button to edit the parameters for the job. The new
parameters are only effective for the current day's batch
run.

View Menu

See View Menu for information about the options in the View menu.

Status Detalls for Job

Certain status values on the Batch Jobs section such as 'Error' or 'Long Running' act as a
link. When clicked a popup is displayed containing more details about why the job is in the
given status and helpful suggestions for resolving the issue. An example is shown below for a

job in error.

ORACLE

2-19



Footer

ORACLE

Chapter 2
Batch Monitoring

Details on Error Job W_RTL CURE_MCAL G JOB ®
REeason This Job has failed during execution at the Agent.

Paossible Please reach out to the Cracle support team, for further investigation,

Resalution

Error Info Batch Job failed in Job Agent

Job Execution I 1300 Execution Request ID 161

Start Time 05/03/21 04:45:45 COT Execution Request Status  ERROR

End Time 05/03/21 0:46:13 COT

Last Updated 05/03/21 04:46:13 CDT

Download Log Cancel Ok

Auto Refresh: None ¥  Last refreshed: 04/12/22 23:48:46 CDT | Refresh Recove

The screen can be set to auto refresh periodically by selecting the pre-defined interval
from the Auto Refresh list. By default, this value is set to None on page load.

Use the Refresh button to refresh the screen immediately.

Use the Recover button to automatically attempt fixing system failures and resume the
schedule. This is useful if there is a system or communications failure that interrupts
the execution of a schedule.

Last refreshed shows the time and date of the last refresh of the interface.

Batch Job Details

The Batch Job Details screen provides detailed information about a batch job.

Depending upon the status of the job, one or more of the following buttons will be
available at the top of the screen:

Hold

Run - This is available only for Standalone jobs.
Release

Release Skip

Rerun

Skip
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Figure 2-10 Batch Job Details

Batch Job Details g

Job STOP_RIB_ADAPTOR INV_JOB

Job Status: Skipped Release Skip

Executions
Status D JobRunID  Start Tme End Time Log
Q eror 21641 413116 s
Pre Dependencies
Status Job Process

@ Completed DUMMY_START_NIGHT_BATGH_I0B DUMMY_START_NIGHT_BATCH_PROCESS

Post Dependencies
Status Job Process

@ Completed DISABLE_RIB_PUB_TRIGGER_JOB DISABLE_RIB_PUB_TRIGGER_PROCESS

External Dependencies

Inter-Schedule Dependencies

Schedule Links

Status Job Process Schedule
Skipped REFRESHODIVARIABLES_JOB SETUP_PROCESS RDE Retry
Callbacks
Status Job Process Payload info
Q Failed STOP_RIB_ADAPTOR_INV_I0B STOP_RIB_ADAPTOR_INV_PROCESS Payload info Retry

Figure 2-11 Batch Job Details with Status Information

Batch Job Details

Job LIKESTOREBATCH_JOB

@ Jobstatus: Eror
Reason: This Job has faied during execution at the Job Admin. Sp | Rerun
Resoltio: Please reach out to the POM support team, for futher nvestigaton.

Execution Requests

Staty Execution ID RuniD  Request Time
] 101 Error Info
Executions
Status ) JobRunD  Start Time End Time Log
& error 02/23/2115:15:10 CST 02/23/2115:15:10 CST *

Pre Dependencies

Post Dependencies

External Dependencies
Inter-Schedule Dependencies
Schedule Links

Callbacks

Execution Requests

ORACLE

If the job was executed, this section displays the following information about the job
execution:

e  Status
e Execution ID
* Request Time

»  Error Info - This will only show in case of an error status.
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If the job was executed, this section displays the following information about the job
execution:

Status

ID

Job Run ID
Start Time
End Time

Log - Provides a link to download the execution log.

Pre Dependencies

This section displays the following information about job pre-dependencies:

Status
Job - Click to open the job in the Batch Job Details screen.
Process

A Disable/Enable button is available for jobs that have not yet completed.

Post Dependencies

This section displays the following information about job post-dependencies:

Status
Job - Click to open the job in the Batch Job Details screen.
Process

A Disable/Enable button is available for jobs that have not yet completed.

External Dependencies

ORACLE

External Dependencies

Status Job

Pending Testing Job Disable

An external dependency is usually a dependency on a customer's internal process.
This dependency is released once the customer calls an endpoint into POM for a
specific POM job. This section displays the following information about job external
dependencies:

Status
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» Job - Click to open the job in the Batch Job Details screen. The job that, when complete,
will release the dependency which the currently displayed job is waiting on.

* A Disable/lEnable button is available for jobs that have not yet completed.

Inter-Schedule Dependencies

Inter-Schedule Dependencies

Status Job Process Schedule

Pending ALCDETAILSSDE_JOB ALCDETAILSSDE_PROCESS RDE Disable

An inter-schedule dependency links the current schedule and a target schedule where a job
in the target schedule is dependent on the completion of the currently displayed job in the
current schedule. This section displays the following information about job inter-schedule
dependencies:

e  Status

e Job - Click to open the job in the Batch Job Details screen. Job which is dependent on
the source job.

* Process - Process containing the job.
*  Schedule - Schedule containing the process/job.

- A Disable/Enable button is available for jobs that have not yet completed.

Schedule Links

ORACLE

Schedule Links

Pending ALCDETAILSSDE_JOB ALCDETAILSSDE_PROCESS RDE Disable

This section displays the following information about schedule links for a job:

e Status

» Job - Click to open the job in the Batch Job Details screen. The job in the Target
Schedule that., when completed, will fulfill the dependency for the currently displayed
schedule.

» Process - The process the job belongs to.

» Schedule - The schedule whose job is a dependency for the job in the current schedule.
* Info - Shows information regarding error if failed or skipped.

- A Disable/Enable button is available for jobs that have not yet completed.

* A Retry button is available for schedule links with a Skipped or Failed status.
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Job Process Date Payload Info

€ Failec WLINT_ORG_DH_RTL_TMP_IOB LOAD_DIM_INITIAL_ADHOC Payload Infa Retry

This section displays the external status update request and response callbacks based
on the External Status Update mode set in the External System Configuration screen.
This section displays the following information about job callbacks:

Status

Job - Click to open the job in the Batch Job Details screen.

Process

A Payload link to display the Payload Window for the callback.

An Info link to display the Info Window describing the callback response.

A Retry button is available for callbacks with a Skipped or Failed status.

Payload Window

The callback payload window shows the field name and value for each field in the
payload.

Select Done to close the window.

Figure 2-12 Callback Payload Window

Info Window

STOP_RIB_ADAPTOR_INV_JOB Payload X
externalURL http://nsh008888dwk.us.oracle.com:8018/ExternalCallbackTestAp...
processName MERCH_DUMMY_START_NIGHT_BATCH_PROCESS
processExecutionld MERCH_DUMMY_START_NIGHT_BATCH_PROCESS~316
activityName STOP_RIB_ADAPTOR_INV_JOB
activityExecutionld 413116
callBackServiceDataDetail.rootProcess MERCH_DUMMY_START_NIGHT_BATCH_PROCESS
callBackServiceDataDetail.rootProcessExecld MERCH_DUMMY_START_NIGHT_BATCH_PROCESS~316
status ERROR
activityStatus ACTIVITY_FAILED

Dane

The callback info window shows information about a request and response.

ORACLE
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Select Done to close the window.

Figure 2-13 Callback Info Window

STOP_RIB_ADAPTOR_INV_JOB Info X

Received ReST Exception : javax.ws.rs.ProcessingException: java.net.UnknownHaostException: nsh008888dwk.us.oracle.com
Exception : External Callback system cant be validated

Done

Status

Status

The Status sidebar displays information about the Scheduler, Execution Engine, and the
environments that Process Orchestration and Monitoring communicates with to execute
batches.
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Figure 2-14 Status Sidebar

Environment Status p4

Last Updated: 4/12/22 at 11:28PM o

i‘ Scheduler Admin

®) Execution Engine Config

€3 MERCH
Health Checlk

O Active
€9 RDE

Health Check &

D Active
€9 R

Health Checlk

D Active

€9 RPASCE
Health Check &

D Active
€9 RsP

Health Check &

D Active

Scheduler

Displays the status of the Scheduler, and an Admin link to enable or disable the
scheduler for a particular batch schedule in the Scheduler Administration window.
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Execution Engine

Displays the status of the execution engine, and a Config show configuration of the
execution engine in Execution Engine Configuration.

Environment Statuses
Displays the following for each environment:

Figure 2-15 Environment Status

1 23 4

/N

Health Check

O Active€=5

1. Status - Icon indicating the current status of the integration with the environment. This
will be either success o or error ":‘

Environment - Abbreviation of the environment name.

Health Check - Opens the Health Check for the environment.

Link - An icon which indicates if Inter-Schedule Dependencies are enabled or disabled.

o > w D

Activellnactive Switch - Turning the switch deactivates the job agent for the
environment.

Download Cycle Summary

Use the Download Cycle Summary window to download information about a completed batch
cycle:

1. Click Download Cycle Summary in the Batch Jobs Header.

The Batch Cycle Summary window opens.

Figure 2-16 Download Cycle Summary Window

Download MERCH Cycle Summary for 08/18/20 X

Cycle Standalone v

Type (@ CSV JSON

Cancel Download Open Report
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2. Use the Cycle menu to select the cycle for which to download the summary.
3. Select the Type of data to download: CSV (comma-separated values) or JSON.

4. Click Download to download the summary file, or click Cancel to close the
window without downloading.

Scheduler Administration Window

The Scheduler Administration window allows you to enable or disable batch
schedules.

When the Scheduler is disabled for a particular schedule, tasks will still be scheduled
and will still trigger at the specified time but will immediately move to the Canceled
state.

Select the Done button to close the window.

Figure 2-17 Scheduler Administration Window

Scheduler Administration

Administration
R D) Active
rse @) Active

roE @) Active

MERCH @)  Active

Execution Engine Configuration

The Execution Engine Configuration window displays configuration of communication
between the user interface and the execution engine.

Select the Done button to close the window.

This window displays the following configurations:
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Figure 2-18 Execution Engine Configuration Window

Execution Engine Configuration X

Configuration

Executor Service Palling Interval ¢ Seconds

Monitoring Service Polling Interval Seconds

15

Thread Paool Size 100

* Executor Service Polling Interval - Determines the number of seconds between each
polling interval for the batch execution process on Process Orchestration and Monitoring.

* Monitoring Service Polling Interval - Determines the number of seconds between each
polling interval for the monitoring process on Process Orchestration and Monitoring.

»  Thread Pool Size - Maximum number of concurrent threads permitted for use by the
Execution Engine.

Health Check

The Health Check window displays the status of the processes communicating with the
environment.
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Figure 2-19 Health Check Window

RSP Health Check

Severity

€3 ERROR

€3 ERROR

€3 ERROR

& SUCCESS

® Success

& success

b 4
~
Source
POM - PSRAF
PSRAF is not configured
[BASIC_AUTH]
External Callback
Received ReST Exception : javax.ws.rs.ProcessingException: java.net.ConnectException: Tried all: '1" addresses, but could not
connect over HTTP to server: 'nsh00dwk.us.oracle.com’, port: '8' failed reasons: [0]
address:'nsh00dwk.us.oracdle.com/10.91.129.60",port:'8' : java.net.ConnectException: Connection refused
http://nsh00dwk.us.oracle.com:8/ExternalCallbackTestApp/batch/test [BASIC_AUTH_MODE]
Job Admin Agent [RSP]
Unauthorized : Recheck Map [ProcessServices.oracleretail.apps.process.services.app], Keylprocessservicesadmin]
http://nsh0Qeai.us.oracle.com:8010/RmsJobAdminAgent [BASIC_AUTH_MODE]
Execution Engine
Available
http://nsh00jul.us.oracle.com:8020/ExecutionEngine [BASIC_AUTH_MODE]
Execution Engine - Job Admin [RSP]
Available
http://nsh00eai.us.oracle.com:8010/jos-rms-batch-job-admin [BASIC_AUTH_MODE]
POM - Job Admin RSP
Available
http://nsh00eaius.orade.com:8010Jos-rms-batch-job-admin [BASIC_AUTH_MODE]
v
Done

This window displays the following for each communication process:

» Severity - The severity of any errors in communication:

- 0 SUCCESS - The process communicates successfully.

- i’B ERROR - The process is not communicating with the environment.

* Source - The name of the process and the response received by the process.

Activity Feed

The Batch Monitoring screen includes an Activity Feed icon at the top right corner.

When the icon is clicked, the Activity Feed panel opens on the right side of the screen.
The panel displays up to seven days’ worth of activities performed both by the system
and by users through the user interface.

Click the close window icon () to close the window.

ORACLE
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Figure 2-20 Activity Feed

Activity Feed X

02/23/21
09:31:38 C5T
POAM_ADMIN

Action [External Asscciation of ty

pe external enabled] on Process/)
ob [DUMMY_EMD_NIGHT_BATCH

_PROCESS/DUMMY_EMD_MIGHT_
BATCH_IQE] for External Job [DU

MMY_END_MIGHT_BATCH_JOB] w
ith a8 comment [Enabling the exte
rnzl dependeciss]

02722721

14:35:00 CST
POAM_SCHEDULE_ADMIN
Action [JOB_SKIP_ERROR] on Pro
cess [RDE_START_RIE_ADAPTOR_|
MNV_24x7_PROCESS] / Job [START_
RIB_ADAPTOR_INV_IOB] with co
mment [Skipping the job ]

02/22/21
14:19:35 CST

System Configuration

The System Configuration screen allows an administrator to modify parameters and
connection properties for the environments integrated with Process Orchestration and
Monitoring. It also allows an administrator to maintain POM application level configurations.

Select System Configuration in the Navigation Area to open the System Configuration
screen and select the Schedules tab. This tab displays the schedule level configurations for
each schedule setup for this environment.
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Batch Monitoring X

Schedules SRS

MERCH 21.6

System Configuration X

Business Date: 01/19/22 System Options

Last Schedule Update:
Settings e
Data Retention Days 2
Long Run Average Time Multiplier 3
External Dependencies Enabled
InterSchedule Dependencies Disabled
Throttling ’
Job Agent ALLOC Throttle Limit 12
Environment s
ALLOC 22.1.201.0
RMS 22.1.201.0
External Configuration s
External URL

External Status Update Mode FAILED
Credentials Yes
Job Type s

No Job Types Configured

Configure New Schedule

ORACLE

RI21.13.20

Business Date: 01/22/22 System Options

Last Schedule Update:
Settings s
Data Retention Days 3
Long Run Average Time Multiplier 22
External Dependencies Enabled
InterSchedule Dependencies Disabled
Throttling s
Job Agent RIS Throttle Limit 13
Environment s
RIS 22.1.201.0
External Configuration 7
External URL

External Status Update Mode NONE
Credentials Yes
Job Type s

No Job Types Configured

RDE 21.18.001.20

Business Date: 03/22/22 System Options

Last Schedule Update:
Settings s
Data Retention Days 30
Long Run Average Time Multiplier 2
External Dependencies Enabled
InterSchedule Dependencies Enabled
Throttling s
Job Agent RDE Throttle Limit 12
Environment s
RDE 22.1.201.0
External Configuration 7
External URL

External Status Update Mode NONE
Credentials No
Job Type s

No Job Types Configured
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Global Edit

RSP 21.5.100.10

Business Date: 02/12/22
Last Schedule Update:

System Options

Settings s
Data Retention Days 35
Long Run Average Time Multiplier 5
External Dependencies Enabled

InterSchedule Dependencies Enabled
Throttling s
Job Agent RIS Throttle Limit 4
Environment s
RIS 22.1.201.0
External Configuration 7
External URL

External Status Update Mode ALL
Credentials No
Job Type s
CITCUSTOM

MOCKTEST

Configure New Schedule

RPASCE 19.0.(

Business Dat¢
Last Schedule

Settings
Data Retentic
Long Run Ave
External Depe
InterSchedule

Throttling
Job Agent RP

Environmer

RPASCE

External Col

External URL
External Statt
Credentials

Job Type
No Job Types

When POM is first installed for a specific customer, it does not include any application
batch schedules out of the box such as Merchandising, Retail Intelligence, and so on.
An Oracle administrator or a system integrator needs to first configure those schedules
before they can be loaded (from a batch schedule spreadsheet). Configuring a new
schedule entails setting up schedule properties such as the schedule name and
description, customer environment information for callbacks. It also entails setting up
the location of different components and services with which different POM
components need to interact to function properly.

Configuring a new schedule is typically done upon provisioning the environment by
Oracle operations. If for any reason the configuration has not yet been done by Oracle,
an administrator can alternatively accomplish that through the UI.

To configure a new schedule, click the Configure New Schedule button at the top
right of the Schedules tab of the System Configuration screen. The Configure New
Schedule window is displayed.

2-32



ORACLE

Figure 2-22 Configure New Schedule

Configure New Schedule

Schedule Configuration
* Schedule Name

Description

External System Configuration

Job Agent
Name URL

+ Add Another

Schedule Variables
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Job Type

Name url OAuth Scope

+ Add Another

URL

Type Variable Name Value

assword + Add Another

Platform Services Services

Type Application URL
URL yp PPl

BDI Process Flow ~
URL

X X X X

RMS Web Services
URL

IDCS URL

IDCS URL for CFS o Cancel oK

The following new schedule information can be set on this window:

Schedule Configuration - This is for identifying and describing the schedule. Attributes
for this section are:

— Schedule Name - A short identifier of the new schedule. This usually matches the
main application name such as Merchandising, RI, and so on.

— Description - A short description of the schedule.

External System Configuration - This identifies an external system, typically a
customer's environment. This is needed for optionally notifying the customer's system of
a job failure or success. This feature is also referred to as Callback. Attributes for this
section are:

— URL
— Username
— Password

Platform Services - Internal Oracle services for retrieving information stored there by
other applications or systems. Attribute for this section is:

- URL

Job Agent - The Job Agent is a component of POM responsible for submitting the
request to execute a batch job. This is usually deployed in the same location as the
application where the jobs actually run. If the schedule being configured contains multiple
applications, it is optional to add an agent for each application. This isn't a common
practice however as an agent can handle running multiple applications. Attribute for this
section is:

- URL

Schedule Variables - These variables hold System (POM) level configurations such as
IDCS or OCI IAM URL, or Job level configurations such as batch directory, DB_ALIAS,
and so on. The job level configurations can also be defined on the batch schedule
spreadsheet. Attributes for this section are:

— Type - Job or System
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— Variable Name
— Value

* Services - This section allows for entry of services POM integrates with. These
include the BDI Process Services, IDCS or OCI IAM, and all services
corresponding to the different applications with service-type batch jobs. Attributes
for this section are:

— Type - This is a drop down for all the possible service types; for example, the
RI Web Services URL which POM would use to invoke RI service-based batch
jobs.

— Application - Application Name to which this service corresponds such as RI.
— URL

* Job Type - This is an optional section for setting up one or more custom job types
other than the standard, pre-defined job types provided by the retail applications,
such as EXEC, RI, RASE, BDI, and RPAS. The user then associates a custom job
type with the base URL for endpoints at the destination system. These are
endpoints for starting a job, restarting a job, killing a job, checking status of a job,
fetching the log for a job, and validating the URL. By setting up a custom job type,
the user must then create a custom schedule spreadsheet containing jobs with
that job type. When this batch schedule runs, POM executes that job using the
corresponding, defined Start endpoint. If the user misses the opportunity to
configure the job type at this point, they do have the opportunity to add that using
the Job Type Configuration screen (see Edit Job Type for more information).
Attributes for this section are:

— Name — A short, alphanumeric identifier of the job type. This typically reflects
the system or application where associated jobs are to be executed (for
example, RDS).

— URL - Base URL for endpoints at the destination system where batch is to be
invoked (for example, https://server/services/batch).

— OAuth Scope — Authentication scope for accessing the batch endpoints at the
above URL.

Schedule Settings and Connections Configuration

Select the Schedules tab on the System Configuration screen to configure the
settings and connections for an environment.

The following information is shown for each environment:

MERCH 21.6

e Schedule name abbreviation.

*  Schedule version number.

Business Date: 08/19/20

Last Schedule Update:
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» Business Date - Date for which the specific schedule's batches will run next.

» The system options are a set of key-value pair of attributes and values specific to the
given schedule such as location of directories or throttle enabling setting. System options
can also be used to define shell script warning or error exit codes. If any such codes are
specified, they will cause a shell script based job to fail or complete with warning.

Examples of system options:
Last Schedule Update - Last date on which the schedule was updated.
*  System Options link

Each Schedule is associated with a number of system options specific to its environment

and settings. Those can be edited by clicking the System Options link located next to
the Business Date.

Figure 2-23 Edit System Options

System Options for MERCH Job Admin
Options
Key Value

AllocppUse:

RMSAppUser

RPMAppUser Edit Remove

ReminductionDir Edit Remove

RpmPublishDir

Edit Remove

/batch Edit Remove

The system options are a set of key-value pair of attributes and values specific to the
given schedule such as location of directories or throttle enabling setting. System options
can also be used to define shell script warning or error exit codes. If any such codes are
specified, they will cause a shell script based job to fail or complete with warning.

Examples of system options:

Key Value

enableThrottling FALSE

WarningCode110 Some input files were not processed
ErrorCode40 Input file corruption detected

The user can edit the values, add or remove options.

* Settings - See Edit Settings for detalils.
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Settings

Data Retention Days
Long Run Average Time Multiplier
External Dependencies

InterSchedule Dependencies

— Data Retention Days
— Long Run Average Time Multiplier
— External Dependencies

— InterSchedule Dependencies

* Throttling - See Edit Throttling for details.

Throttling
Job Agent RPASCE Throttle Limit

— Job Agent Throttle Limit

Chapter 2
System Configuration

]

rd

30

2
Enabled
Enabled

10

Environment - See Edit Environment for details.

Environment

RPASCE

rd

21.0.000

— Job Agent name (for example, RPASCE). This also acts as a link which, when
clicked, opens the Job Agent Configuration Window.

— Job Agent version

* External Configuration - See Edit External Configuration for details.

External Configuration 4
External URL

hitpe/frz - b e D _Z ) ExternalCall...
External Status Update Mode NONE
Credentials Mo
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— External URL
— External Status Update Mode
— Credentials

* Job Type - See Edit Job Type for details.

Job Type g

RDS

— Job Type - For example, RDS.

Edit Settings

To edit the settings for an environment, click the edit icon #" in the Settings section to open
the Settings window.

Figure 2-24 Edit Settings Window

Settings for RPASCE 21.1 X
* Data Retention Days 30 VoA
* Long Run Average Time Multiplier 2 VoA
* Default Average Run Time O ~
* Business Date: 04/08/21 bl
Background Jobs | Disabled

External Dependencies D Enabled

InterSchedule Dependencies D Enabled
Repave Strategy @) Fixed Variable

* Window Duration 60 ¥ | A Spconds

Cancel OK
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The following settings are available in this window:

Data Retention Days - Number of days for which data is to be retained

Long Run Average Time Multiplier - Used to calculate when a job is considered
long running.

A job is long running when its current run time is longer than this number times
than the average run time of that job. For example, if a job's average run time is 3
minutes, and the Long Run Average Time Multiplier is 3, then the job is considered
long running if it has been running for at least 9 minutes. A notification is sent
when a job is deemed long running.

Default Average Time Multiplier - This multiplier is used in lieu of the Long Run
Average Time Multiplier when the latter has no value.

Business Date - The earliest business date for which to run batch schedules. See
Business Date Explained for an explanation of how POM uses this setting.

Background Jobs - Enable or disable background jobs.

External Dependencies - A switch for enabling or disabling external
dependencies.

InterSchedule Dependencies - A switch for enabling or disabling InterSchedule
dependencies.

Repave Strategy - This strategy together with the next field's value is used to
determine if a job should be allowed to run on a particular server node. When a
node is scheduled to be repaved (updated with the latest software patch), no batch
job should be running on it when the repave starts. To prevent such a situation, a
best guess is needed as to when a node should stop accepting jobs to be run.
There are two strategy for determining when that time is:

— Fixed: Uses the next field's value (Window Duration - in seconds) to
determine the time at which the node will start rejecting requests for running
jobs. For example, if this value is 3600 seconds, the node will stop accepting
requests one hour before the repave starts.

— Variable: Multiplies the next field's value (multiplier) with the job's average run
time to determine if the node likely has enough time to run the job to
completion. For example, if the multiplier is three and the job about to be
submitted for running on this node has an average run time of five minutes
and the repave is due to start at a time longer than the 15 minutes (the product
of the two numbers), the job will be allowed to run. Otherwise it won't be.

Window Duration / Multiplier - This field is dynamically altered depending on the
previous field's value and is used in conjunction with the previous field. See the
previous field's explanation for details.

Select OK to save the changes, or select Cancel to exit the window without saving
changes.

Business Date Explained

ORACLE

When the business date is initially set, it's supposed to be set as the First Run
Business Date. It's meant for the POM application to compare to the Current Business
Date (shown below the Business Date on the screen). If the (First Run) Business Date
is earlier than the Current Business Date, POM will run the next batch schedule for the
day after the Current Business Date. If the (First Run) Business Date is later than the
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Current Business Date, POM will run the next batch schedule for that date rather than the
day after the Current Business Date.

# Note:

The Current Business Date advances automatically every time batch completes for
the day

The reason the (First Run) Business Date is updatable on this screen, is to give the ability to
start the next schedule run at that date, skipping some run days. Here are a couple example
scenarios:

Scenario 1: Common Scenario

System Configuration screen's Business Date: 11/28/2019

System Configuration screen's Current Business Date: 08/12/2019
The next batch schedule run will be for business date 08/13/2019.

When that batch run starts, the Current Business Date advances to 08/13/2019 and the
screen is updated accordingly.

Scenario 2: Skip a Few Days

System Configuration screen's Business Date: 11/28/2019

System Configuration screen's Current Business Date: 08/12/2019

User changes the Business Date on the System Configuration screen to 08/18/2019
The next schedule run will be for business date 08/18/2019.

When that batch run starts, the Current Business Date moves to 08/18/2019 (since the (First
Run) Business Date is greater than Current Business Date) and the screen will be updated
accordingly. The (First Run) Business date will remain at 08/18/2019 until changed by an
administrator on this screen.

Edit Throttling

ORACLE

The throttling settings can be changed by selecting the edit icon #"inthe Throttling section to
open the Throttling window.
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Job Agent RMS

Application

ALLOC

REIM

RESA

RM5

RPM

Throttling for MERCH 19.2.666

Throttling Value

11 v A
10 v | A
10 v A
10 v A
10 v A

Cancel

(0] 4

This window allows for update of the throttling value for each application hosted on this

Job Agent.

Select OK to save the changes, or select Cancel to exit the window without saving

changes.

Edit Environment

ORACLE"

The environment settings can be changed by selecting the edit icon #"in the

Environment section to open the Environment window.

" Note:

request to execute a batch job.

One schedule can be supported by one or multiple Job Agents. Usually, the
mapping is one Job Agent to an application.

Also, the Job Agent is a component of POM responsible for submitting the

2-40



Chapter 2
System Configuration

Figure 2-26 Edit Environment Window

Environment for Rl 21.13.20 x
Platform Services URL ht(p://server:port/..../Retai\AppsPIatformServfcesl
Services
Job Agents
Application Name URL Version
RI v RIS http://pomagentservice:8080/POMAgent 22312010 X
+ Add Another
o
Environment for Rl 21.13.20 x
Platform Services URL http://server:port/.../RetailAppsPlatformServices
Job Agents
Services
Type Application URL
Rl Web Services URL v RI v xyz.com X

+ Add Another

(o) o

At the top of the Environment window, the user can set the Platform Services URL.
The window then provides two tabs: the Job Agents tab and the Services tab.

On the Job Agents tab, the user can add or change the following Agent related information:
* Application - application name

* Name - Agent's name

* Job Agent Version - Release version of the Agent

* Job Agent URL

On the Service tab, the user can add or change services related information. These are
services that POM integrates with, such as BDI Process Services, IDCS or OCI IAM, and all
services corresponding to the different applications with service-type batch jobs.

Select OK to save the changes, or select Cancel to exit the window without saving changes.

Job Agent Configuration Window

ORACLE

The Job Agent Configuration window displays configuration information about the selected
Agent.

An Agent is the component usually deployed alongside the application for which the batch
runs. It receives requests from the POM application, usually deployed on a common server.
These requests direct the agent to invoke the actual job execution on the target application.

Select the Done button to close the window.
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Figure 2-27 Job Agent Configuration Window

RIS Agent Configuration

Configuration Settings
Name Value
supportedApps RSP

scheduleMame RI

Throttle Groups

Group Name Throttle Limit
RI 13
RI_RI 13

Configuration URLs

Type Url
RIWSURL for RI XyZ.com
RIWSURL dummy

POM

RPASWSURL for rpasce xyz

IDCS

BDIPFURL
RIWSURL wz
RASEWSURL servige! '~~~ x
Job Types Configuration
Job Type Defination Url
ENG Info 8T
FRA Info www n

crreustom

SyncWith POM | Refresh | Done

This window displays information about the Agent's Configuration Settings, Throttle
Groups and Job Types.

It also displays a Configuration URLs section which lists service URLs that POM
needs to operate. These include service URLSs for calling endpoints to execute batch in
the case where the jobs are service-based (versus shell-script-based) and are of pre-
defined job types such as RI, RASE and RPAS.

The Throttle Groups section displays throttle limits (the maximum number of job that
can execute concurrently). These are defined either on the batch schedule
spreadsheet or on the Throttling section of this System Configuration screen.

The Job Types Configuration section displays all custom job types defined either on
the batch schedule spreadsheet or on the Job Type section of this System
Configuration screen.
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This window also features a Sync With POM button (formerly called Publish). When clicked,
it will synchronize the information on this screen from POM to the Job Agent. These changes
are also synchronized automatically to the Job Agent upon the daily creation of a new
scheduler day.

Edit External Configuration

The external configuration settings can be changed by selecting the edit icon #"inthe
External Configuration section to open the External Configuration window.

Figure 2-28 Edit External Configuration Window

External Configuration for RSP 19.0.0 X
External Status URL  httpi// /Extern
External Status Update Mode ALL w

Credentials | Update Credentials

Cancel OK

The following settings are available in this window:

» External Status URL - Customer system's URL that is called when POM is to notify the
customer's system. Note that this calling feature is also referred to as Callback.

» External Status Update Mode - Job status for which POM is to call the customer's URL.
This menu has the following options:

— ALL - POM will make a call for each job's execution regardless of success or failure.
— FAILED - POM will make a call only for failed jobs.
— NONE - POM will never make a call.

* Update Credentials - When clicked, User Name and Password fields are shown. Setting
these values will update the credentials POM uses to call the customer's URL.

Select OK to save the changes, or select Cancel to exit the window without saving changes.

Edit Job Type

The job type configuration can be changed by selecting the edit icon #"in the Job Type
section to open the Job Type Configuration window .
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Figure 2-29 Job Type Configuration Window

RSP Job Type Configuration

Job Types

cITcusToM

This window displays a table of configured job types. Each row contains the following
fields:

Job Type - A short, alphanumeric identifier of the job type. This typically reflects the
system or application where associated jobs are to be executed (for example, RDS).

URL - Base URL for endpoints at the destination system where batch is to be Invoked
(for example, https://server/services/batch).

Job Start - Endpoint for invoking the execution of a job.

Job Restart - Endpoint for restarting the execution of a job after failure.
Job Status - Endpoint for POM to fetch the status of a started job.

Job Kill - Endpoint for terminating the execution of a running job.

Job Logs - Endpoint for fetching the log(s) for a job.

Validation - Endpoint for validating that the endpoints are reachable.
Scope - Authentication scope for accessing the above endpoints.
The user can edit or delete an existing row, or create a new job type.

Select OK to save the changes, or select Cancel to exit the window without saving
changes.

See the POM Implementation Guide for additional details on setting up custom
schedules with custom job types.

System Settings

Select the System tab in the System Configuration screen to view the system
configuration for Process Orchestration and Monitoring.
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Figure 2-30 System Information Screen

Schedules

POM 22.1.201.0

Environment Name
) PR 1000

Customer Name
PUL <

Process Services URL
Platform Services URL

Deployed on CFS
false

Edit System Settings

Select the edit icon # (not shown) located at the rightmost of the System Information window

to enable the editing of information on this window.

Figure 2-31 Edit System Settings Window

System Settings

System

Environment Mame

Customer Mame

Environment

Process Services URL
Platform Services URL

Deployed on CFS

snphxprshared

POMCustomerMame

https://

https:/fr-'

ey PROCESS SRMVICES

J— latformServices

E

ORACLE"
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The following settings are available in this window:

* Environment Name - This is the physical environments name such as '<customer
name> stage 1'.

¢ Customer Name

* Process Services URL - This URL is set at install time and cannot be changed on
this window. It shows the value of POM's services URL.

» Platform Services URL - This URL is set at install time and cannot be changed
on this window. It shows the value of the Platform Services URL.

» Deployed on CFS - A flag indicating whether this environment is on the Oracle's
CFS platform.

Select OK to save the changes, or select Cancel to exit the window without saving
changes.

Global Edit

Select the Global Edit button to open the Global Edit screen. This screen sets
configurations for all the schedules. Refer to the sections above for explanation of the
different configurations.

Figure 2-32 Global Edit Screen

Global Edit

‘ @ Select fields to apply as updates to all schedules.

Settings

Time Multiplier

External Configuration

Apply Label Value

External URL

Use the Apply check boxes to activate the fields for the settings to be applied to all
schedules. The following settings can be applied to all schedules:

e Data Retention Days

e Long Run Average Time Multiplier
* Business Date

e Background Jobs

e External Dependencies
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* InterSchedule Dependencies
* External URL
* External Status Update Mode
* Repave Strategy
* Credentials:

— Username

— Password

Batch Administration

The batch administration screen provides the ability to maintain information specific to the
batch schedule.

Select Batch Administration in the Navigation Area to open the Batch Administration tab.

Figure 2-33 Batch Administration

o RSP 19,1004 RPASCE 21,0,

)
Nighty

Nighty onty. 52
R % 0

612
1485

Sta

Nightyy 400) | Recurring 0744 || EIA) Smcwith MOF | Export Config | Import Config

MERCH Adhoc

actons + view o [l <o it

Job Pracess Name

Applcation Module status KON punTime  Notes Job Nam Job Wrapper Name

ADMIN_AP|PURGE_PROCESS RMs

mswiap_shellksh

~ALC_DASHBOARD_REFRESH PROCESS_.. ALLOC
ALC_PLAN_PROCESS ADHOC Auoc

ALC_RECEIPT_PLAN PROCESS_ADHOC  ALLOC #5ys0pt dbwallet exec None

ALC_SIZE_PROFILE PROCESS ADHOC  ALLOC #550pt. abwalet exec None
RMs
Rus

Rus

Rus
Rus
L. RMS
RMs
RMS

BDLtemHarTL Fd_PF_From RMS_PRO... RMS

299599599909999 £

Batch Administration Header

The Batch Administration header includes the following options:

1. Batch Tiles - There is a batch tile for each software environment Process Orchestration
and Management connects to. Select a tile to show the batch processes for that
environment. See Batch Tiles for more information about these tiles.

2. Cycle Tabs - Displays the cycles for which batch information is to be maintained.

Select a cycle tab to see the batch details for that cycle. The following cycles are
available:

*  Nightly
* Recurring
e Standalone

3. Export Config - Use this button to export configurations for the selected schedule and
cycle. These configurations include Scheduler tasks, throttle limit values, data retention
values, notifications settings and (most importantly) which jobs are enabled or disabled.
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When clicked, the user is presented with a dialog for selecting the type of file to
export (JSON or Excel)

Export X

Export As E] s Json

Cancel Ok

Depending on the user's browser setting, the file is either saved in the default local
file system directory or a file save/open dialog is presented first.

Opening RI_config.json X

You have chosen to open:

E RI_config.json
which is: JSON file (375 KB)

from: data:

What should Firefox do with this file?
O Save File

[ ]Do this automatically for files like this from now on.

oK Cancel

If the export is done for the purpose of applying the same configurations on
another environment (Lift & Shift), the user is recommended to export to a JSON
file. This file is then used in the Import Config function (explained below) to import
the configurations into another environment.

The user has the option to manipulate the exported file before importing back into
the same environment or a different one. In that case an export to an Excel file is
more suitable for ease of manipulation. Caution needs to be taken when
manipulating the content of the exported file, especially for maintaining proper data
format.
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Refer to the “Export/Import Schedule Configuration” chapter of the Process Orchestration
and Monitoring Implementation Guide for details on applying changes to the exported
spreadsheet before importing it back in.

Import Config - Use this button to import new batch configurations for the selected
schedule and cycle. When clicked, the user is presented with a dialog to select the
desired type of import.

Import Configuration for Rl x

Warning
Importing a schedule configuration will alter the current schedule's configuration
including enabling or disabling jobs. Are you sure you want to continue?

v Import Scheduler Configuration

v| Import Jobs Configuration

Import Notifications Configuration

Close Import Config

The user can select to import Scheduler tasks configuration and/or Jobs configuration
and/or Notifications configuration. The jobs configuration includes such settings as
throttle values, data retention values, enabled/disabled setting and Job Start/Completion
notifications. The Scheduler tasks are those directives for the POM Scheduler to run the
different batch cycles at specified times. The Notifications configuration includes e-mail
addresses and retention periods associated with the different notification types.

Once the import type is selected and the Import Config button is clicked, the user is
presented with a file selector dialog (not shown). User can then choose to import a JISON
or an Excel file.

When a schedule is being upgraded using the Schedule Maintenance screen or when the
schedule upgrade has failed, the user is prevented from most activities on the Batch
Monitoring and on the Batch Administration screen.

| ) Some festures are dizabled while 3 schedule iz being imported

| ) Some festures are diszbled while 3 schedule iz in 2 failed state

Each tile displays the following information:
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Figure 2-34 Batch Tile

O RSP 18.0.002

Nightly 432
Recurring: 1488
Standalone: 32

1. Schedule Name and Version - Displays the abbreviation of the application or
application group and the software version.

2. Cycles and Statuses - Displays the number of batch processes for each cycle.

The information in the batch list depends upon the cycle chosen:
* Nightly
* Recurring

e Standalone

Actions Menu and Icons

View Menu

Nightly

ORACLE

Actions Menu and Icons
See Action Menu and Icons for common actions that can be performed through the
Action menu and the icons. You can also perform the following actions:

Table 2-2 Batch Jobs - Actions Menu/lcons and Description
|

Actions Menulicons Description

Edit and Edit icon # Select an it?m in the table, then select Actions > Edit or the
edit icon # to edit the item.

Enable All Use the Actions > Enable All or the Enable All button to
put the process on hold.

Disable All Use the Actions > Disable All or the Disable All button to

skip the process.

See View Menu for information about the options in the View menu.

The nightly cycle displays the following information for each batch:
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Figure 2-35 Nightly Batch List

= ORACLE' Orac Retai rocess Orchestration and Monitoring & POMMADMN v @ +
o

[ —

MERCH Nightly

MoF | EpenContg

Enabled
Job - Click the Job to open the batch in the Batch Job Details screen.
Process Name

Application - A schedule may be made up of multiple applications. There needs to be at
least one application.

Module - An application may be made up of multiple modules. Modules within an
application are optional.

Parameters - A job may be run with a list of input parameters. This column always shows
the original list of parameters.

Active Parameter - This column shows the customized list of parameters.

Job Type - A Job Type is an attribute of a Job in POM and signifies the kind of Job that is
run. POM has the following pre-built Job types:

— EXEC - For all shell-script based jobs

— RI - DIS-based jobs for the RI schedule

— RASE - DIS-based jobs for the RSP schedule

— BDI-BDI Jobs

— RPAS - RPAS-Web Service jobs for the RPAS schedule

Kill Cleanup Script - Name of a script that will be executed after the kill is performed. This
is an optional field as not all jobs require cleanup after termination.

External Status Update - Job status for which POM is to call a customer's URL. The URL
is defined in the External Configuration section of the System Configuration screen. This
column has the following possible values:

— ALL - POM will make a call for this job's execution regardless of success or failure.
— FAILED - POM will make a call only for if this job fails.

— NONE - POM will not make a call.

Notification At
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— Start of Job — Send notification of type JobStarted when the selected job
starts.

— Completion of Job - Send notification of type JobCompleted when the selected
job completes successfully. Note that there is a separate notification of type
Error that is sent when a job fails.

e Skip On Error - Skip this job if it fails.

* Threshold Run Time (Seconds) - Amount of time greater than which the job is
deemed long running.

* Notes

e Job Name

e Job Wrapper Name

» Days of the Week - Days of the week for which the job is to be run.

The Recurring cycle includes an Hourly Cycle menu. Select an hour in this menu to
choose the hour of the day during which the displayed jobs will run.

The recurring cycle includes the following information for each batch:

Figure 2-36 Recurring Batch List

= ORACLE' 0ce et roces Ocrstton sns arorn & rowman s @

*  Flows - Select a flow in the Flows list to view all jobs for that flow. The following
information is shown for each flow:

— Flow Name
— Enabled or Disabled

* Jobs - The Jobs list shows the following information for each job. Refer to the
Nightly cycle above for an explanation of each field:

— Enabled
— Job - Click the Job to open the batch in the Batch Job Details screen.

— Process Name
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— Application

— Module

— Parameters

— Active Parameter

— Job Type - Job Type of 'EXEC' Indicates that the job executable is shell script based.
All other job types, such as 'BDI', 'RI', and so on, indicate that the job is service-
based. Service-based job types require different configurations than shell-script
based.

— Kill Cleanup Script - Name of a script that will be executed after the kill is performed.
This is an optional field as not all jobs require cleanup after termination.

— External Status Update

—  Skip On Error

— Threshold Run Time (Seconds)
— Notes

— Job Name

— Job Wrapper Name

— Days of the Week

The standalone monitoring cycle includes the following information for each batch. Refer to
the Nightly cycle above for an explanation of each field:

Figure 2-37 Standalone Batch List

ORACLE’ 0rce Retail Process Orchestration and Monitoring & roamsonn Y @ ¥

S corty

Enabled

Job - Click the Job to open the batch in the Batch Job Details screen.
Process Name

Application

Module
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Parameters
Active Parameter

Job Type - Job Type of '/EXEC' Indicates that the job executable is shell script
based. All other job types, such as 'BDI', 'RI', and so on, indicate that the job is
service-based. Service-based job types require different configurations than shell-
script based.

Kill Cleanup Script - Name of a script that will be executed after the kill is
performed. This is an optional field as not all jobs require cleanup after
termination.

External Status Update

Skip On Error

Threshold Run Time (Seconds)
Notes

Job Name

Job Wrapper Name

Days of the Week

Batch Job Detalls

The Batch Job Details screen allows maintenance of various types of dependencies
associated with a batch job.

Pre Dependencies

ORACLE

Figure 2-38 Batch Job Details

eeeeeee

ssssssss

yyyyyyyyy

il |
This section displays the following information about a job's pre-dependencies:
» Enabled - Switch to enable or disable the pre-dependency.
« Job
* Process
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Post Dependencies

This section displays the following information about a job's post-dependencies:
» Enabled - Switch to enable or disable the post-dependency.
 Job

e Process

External Dependencies

This section allows for the maintenance of the following information about a job's external
dependencies. An external dependency is normally a process internal to a customer's
system.

e Enabled - Switch to enable or disable the external dependency.
 Job

A Remove button is available to delete the external dependency.

Inter-Schedule Dependencies

This section allows for the maintenance of the following information about a job's inter-
schedule dependencies. An inter-schedule dependency is a dependency for the current job
on a job belonging to another batch schedule. The job for which this Jobs Detail screen is
shown will wait for the job entered here.

* Enabled - Switch to enable or disable the inter-schedule dependency.
* Job - Name of job belonging to the other schedule.

*  Process - Name of process containing Job.

* Schedule - Name of other schedule containing the dependency.

A Remove button is available to delete the inter-schedule dependency.

Schedule Links

This section allows for the maintenance of the following information about schedule links for a
job. Schedule links are a way to link schedules together where the completion of the job in
the current schedule causes the start of execution of the dependent schedule.

* Enabled - Switch to enable or disable the schedule link.
» Job - Name of job belonging to the dependent schedule.
» Process - Name of process containing Job.

* Schedule - Name of the dependent schedule.

« A Remove button is available to delete the schedule link.

Scheduler Administration

The Scheduler Administration screen displays information about the different cycles'
Scheduler tasks and allows for their administration.
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When an application's batch schedule is first created within POM, Scheduler tasks are
created for each of the different cycles as follows:

*  One task for Nightly
*  One task for each of the recurring flows
*  One task for each of the standalone processes

The tasks are all originally created in a disabled state.

An administrator would then access the Scheduler Administration screen to configure
all available tasks according to the specific customer's needs.

Nightly Scheduler Task Administration

ORACLE

On the Scheduler Administration screen, the user selects a schedule tile at the top of
the screen and the Nightly tab right below the tile. The Nightly cycle's Scheduler task is
shown in the tasks table below.

¢ Note:

There is only one Nightly Scheduler task, as there is only one Nightly batch
run.

Figure 2-39 Nightly Scheduler Task Administration

1|0 RDE 191003 | © TESTURLS 0.0.00( [©  SCHEDULE! 0.0.00 ] RI19.1.003

o RSP 19.1.002
Nightly: 1

) MERCH 19.2.666
Ni 1

o TEST 0.0.00

| S

MERCH Nightly Scheduler Task

. Schedule
Enabled Flow Name. =

Time Zone

© v Nghty GBHE O] GMT

Time: 05/11/21,034828 UTC  Refresh

The user can either edit the schedule time in-line or select the row, click the edit icon
then edit the schedule run time in the Edit Task Nightly popup.
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Edit Task Nightly

Enabled @]

Schedule Time 03:00PM (5 (UTC-06:00) Chicago - Central Time

Cancel Ok

Recurring Scheduler Tasks Administration

On the Scheduler Administration screen, the user selects a schedule tile at the top of the
screen then the Recurring tab right below the tile then the hourly flow from the drop down to
the right of the Recurring tab. The Recurring flow's Scheduler tasks are shown in the tasks

table.

Figure 2-40 Recurring Scheduler Tasks Administration

Scheduler Administration X

o RPASCE21.1| |© RDE 19.1.003| | O TESTURLS 0.000| |©  SCHEDULE10.0.00| |© RSP 19.1.002| | O RI19.1.003| |O MERCH 192666 | O TEST 0.0.0.0
Nighy: 1 Nighily: 1 Nighily: 0 o Nighty 1 1 Nighly: 1 Nighty o
Recuring: 0 Recurring: 0 Recurring: 0 0 Recuring: 12 0 Recuring: 2088 Recuring: 0
Standslone: 1 ne 0 Standalone: 0 @ 0 Standslone: 2 « o Standalone: 1 Standlone: 0
Nightly (1) Recurring (2088) Standalone (1) Hourly_Cycle_1
MERCH Hourly_Cycle_1 Scheduler Tasks
Actions v View v 7 o n & Detach
Fiter it i
Enabled Flow Name Schedue Time Zone
Time
@ ves  STORE_ORDERS_PURGE.CYCLE amr
O Yes  STOCK_COUNT_PURGE_CYCLE 01:00PM O] GMT
I Cancel oK
[
@ Ve WF_COST_TEMPLATE PURGE CYCLE | 01 00 PM
i 03
|

Time: 05/11/21,01:3243 UTC  Refresh

The user can either edit the schedule time for each task in-line or select a task, click on the

edit icon then edit the schedule run time in the Edit Task popup.

Edit Task RPM_PRICE_CHANGE_INDUCTION_CYCLE

Enabled @)

Schedule Time

Cancel Ok

ORACLE"
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Standalone Scheduler Tasks Administration

In the Scheduler Administration screen, the user selects a schedule tile at the top of
the screen and the Standalone tab right below the tile. The Standalone cycle's
Scheduler tasks are shown in the tasks table.

ORACLE

Figure 2-41 Standalone Scheduler Tasks Administration

Nightly (1) | Recurring (2040) [JRSRERISNe)

MERCH Adhoc Scheduler Tasks

Enabled Process Name Description Frequency.

s REPLINDCTN_PURGE_PROCESS ADHOC Purge Replenish Records Every 15 minutes

) Yes  LIKESTOREBATCH_PROCESS ADHOC Run Like Store batch Every 15 minutes

©
©
@ Yes  BDIVatFnd_PF.From RVS_PROCESSINIT  Vat 801
[ oA

Daily

s REPLINDCTN_PURGE_PROCESS ADHOC Purge Replenish Records 2 Every 15 minutes

Time Zone

00:00 (UTC+05:30) Calcutta - India Standard Time.

1100 (UTC+05:30) Cal

1600 (UTC+05:30) Cal

AR RN

fevis

Time: 02/23/21,06:5036 UTC  Refresh

The user can either edit the schedule time for each task in-line, or select a task then
click the edit icon to change any of the fields shown in the Edit popup below.

The user can also create and delete Standalone tasks.

# Note:

immediately.

The user has the option to enter a blank time as long as a frequency in
minutes is entered. This will cause the first occurrence to execute

Enabled @)

Description

Limit occurrences 1

Prevent start during nightly @)

Edit Task REPL_INDCTN_PURGE_PROCESS_ADHOC x

Purge Replenish Records

Frequean Minutes

v 15 VoA
Fad
@ (UTC+05:30) Calcutta - India Standard Time A

Schedule Time  12:00 AM

Cancel Ok
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< Note:

The Prevent start during nightly switch prevents the task from running while the
Nightly batch is running. However, it won’t stop a run that is in progress when the
Nightly process starts.

Schedule Maintenance

The Schedule Maintenance screen displays information about the batch schedule upgrade
results. You can upgrade a batch schedule to a new version through this screen.

Figure 2-42 Schedule Maintenance Tab

Schedule Maintenance X

[ ] MERCH 19.0.002 RDE 18.0.002.3 RI 18.0.002.6.1 RSP 18.0.002
Error on Stage 5 &—1
Versions 2
Import Latest Schedule K‘ 3
Upgrade Status Version Date Upgraded \/ Description
@  Upgrade Available 19.1 NA Merch Batch Schedule 4 ——— < Upgrade
@  ErroronStage S 19.0.002 05/18/20 NA 5 % Retry :
Current Version 19.0.001 05/18/20 Merch Batch Schedule 7] —
Past Version 161 04/24/20 NA :
M Upgrading (Stage 4) 19.0.005.2 10/05/21 NA 6 % Cancel
=~
® Eror 19.0.005.1 10705721 NA D ) Retry | Concel

1. Batch Tiles - There is a batch tile for each schedule available in Process Orchestration
and Management. Select a tile to show the history of the selected schedule's upgrades or
available upgrades.

2. Import Latest Schedule - Use this button to upgrade the selected schedule from a
spreadsheet. When clicked, a file selector dialog is displayed (not shown).

The import file is a spreadsheet.

3. Update History Status List - Displays information about each past or available upgrade
of the batch schedule. This menu displays the following information for each batch
upgrade:

* Upgrade Status
* Version

» Date Upgraded
*  Description

4. Upgrade - Use this button to upgrade the schedule. This button only appears for
schedules for which an upgrade available.

5. Retry - Use this button to retry a failed update. This button only appears for schedules
that have not completed successfully. The retry will resume the upgrade from the failed
step.

6. Cancel - Use this button to cancel the upgrade for an ongoing upgrade as long as it's in
stage 4 or less, or to cancel an upgrade in an error state.
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When an ongoing upgrade is canceled, it is marked as Error. The user can then
either click the Cancel button again to remove the attempted upgrade so it can be
started over, or click the Retry button to resume the upgrade from the failed step.

7. Download files menu - Use this menu to download schedule files. See Download
Files for more information.

Download Previous Configuration

Download POM Seed File

Download Files

Click on the ellipses then select from the download files menu to download files for an
upgrade version. This menu has the following options:

* Download Previous Configuration
* Download POM Seed File

Download Previous Configuration

Use the Download Previous Configuration option to download a file containing the
specific schedule version configurations. This file is in JSON format.

Download POM Seed File

Use the Download POM Seed File to download an SQL file with POM seed data for
the specific schedule version.

Footer

The screen can be set to auto refresh periodically by selecting the pre-defined interval
from the Auto Refresh list. By default, this value is set to 30 minutes on page load
which means the Auto Refresh is turned off.

Use the Refresh button to refresh the screen immediately.

Last refreshed shows the time and date of the last refresh of the interface.

AMS Ultilities

The AMS Utilities are functions performed only by the Oracle administrators.

Select AMS Utilities from the Tasks menu to display the submenu.
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Menu = Menu =
* -
Tasks . AMS Utilities A
Q, Search fora task | | Q, Search for a task
] il
Batch Manitaring Manual Job Bun
System Configuration Override Job Status
Batch Administration Override Execution Reque...

Scheduler Administration
Schedule Maintenance

AMS Utilities >

The AMS Utilities submenu contains the following tasks:

e Manual Job Run
e QOverride Job Status

*  Override Execution Request Status

Manual Job Run

An Oracle administrator uses the Manual Job Run utility to run a job for a particular schedule
from either the Nightly or Hourly cycle. Once the selections are made, the user clicks on Run
to submit the job for execution. The user then uses the Batch Monitoring screen to monitor
the execution of the job.

¢ Note:

A job that is manually run on this Ul is run standalone without regard to
dependencies.
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Figure 2-43 Manual Job Run

Manual Job Run

Running a Job manually would simply run the job without regard to its dependencies. These Jobs will not be re-run when the Cycle
Schedule b
Cycle -
Job x

Override Job Status

The next AMS Utility is Override Job Status.

Occasionally, a job in POM gets stuck with a status where manual intervention is
needed. This is to reset the status and get the job running for instance. This screen is
used for this purpose.

Figure 2-44 Override Job Status

Batch Monitoring X Override Job Status X

Find Job

Schedule RPASCE

RPASCE Jobs - Standalone

Actions ¥ View v o & Detach Change Status

Status Job Process Name Start Time End Time Last Update

© Loaded MFP_ADHOC_JOB MFP_ADHOC_PROCESS. 05/05/21 01:23:02 CDT

Select the schedule and the cycle to display all jobs for those selections in the Jobs
table.

In the table, select the row for the job you intend to override the status for and click the
Change Status button or select Change Status from the table's Actions menu. The
Change Status popup is displayed.
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Change Status of Job MFP_ADHOC_JOB |

Warning

Excercise extreme caution when overriding a job status as it may lead to unexpected
results including data corruption.

Business Date 04/10/21

Mew Status v

Comments | | paded A | jeast fifteen non-repeating characters
Completed
Held

V—

You are required to enter a comment justifying overriding the job's current status.

Notice the warning message. An administrator needs to understand the impact of overriding
the current status as it may lead to data corruption if an unintended action takes place.

Override Execution Request Status

The next AMS Utility is Override Execution Request Status.

Occasionally, a job in the POM's Execution Engine gets stuck with a status where manual
intervention is needed. This is to reset the status and get the job running for instance. This
screen is used for this purpose.
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BatchMonitoring X System Configuration X Schedule Maintenance X Override Execution Request Status X
Find Job
Schedule RPASCE .
e [N recurs

RPASCE Execution Requests - Standalone

Actions ¥ View ¥ a4 & Detach

Filter Filter Filter e iter

Execution Total

o Status Cydle Flow o

181 © Losded Adhoc Adhoc 1

Execution ID 181 Details

Actions ¥ View v o &f Detach Change Status

Filter Filter Filter Filter Fitter Filter

:;b R Status Job Name Process Job Execution 1D Last Update
482013 © suomitted MFP_ADHOC_JOB MFP_ADHOC_PROCESS 1500 05/05/21 07:23:57 GMT+1

Select the schedule and the cycle to display all jobs for those selections in the Jobs
table.

Select the row in the Details table for which you intend to override the status and click

the Change Status button or select Change Status from the table's Actions menu.
The Change Status popup is displayed.

Change Status of Job VARIABLE_REFRESH_JOB X

Y Warning

Excercise extreme caution when overriding an execution request status as it may lead to
unexpected results including data corruption.

Business Date 05/06/21

New Status v
Comments | Loaded _ | fifteen non-repeating characters for audit
Completed
Held
Cancel OK
Skipped

Running

You are required to enter a comment justifying overriding the job's current status.

Notice the warning message. An administrator needs to understand the impact of

overriding the current status as it may lead to data corruption if an unintended action
takes place.
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Roles

ORACLE

Roles are used to classify users based on job responsibilities and actions to be performed in
the Oracle Retail Process Orchestration and Monitoring application (POM). Using roles, a
user's access can be restricted to specific areas or functions within the application. In POM,
users must be associated with at least one job role in order to access the application.

The following topics are covered in this chapter:
Roles

Functional Access by Role

POM comes available with a set of pre-defined roles described in the table below. In addition
to the roles, the table contains an alias for each role which is used in the next section for
easier reading.

# Note:

The first two roles have thus far been associated with POM's classic user interface
and are being deprecated along with the classic user interface itself. Customers
need to migrate to the other four roles before those classic roles are removed.

These roles have been given similar access in the new user interface as the access
they had in the classic user interface.

Table 3-1 Roles

- _____________________________________________________________________________|
Role Alias Description

BATCH_MONITORING_]JOB Monitor One of the classic user interface roles.
Users within this role are typically
retailer administrators responsible for
monitoring and executing batch. They
can perform select activities on the
Batch Monitor screen to move the
schedule along.

BATCH_BUSINESS_JOB Business User Another one of the classic user
interface roles. Users within this role
are typically retailer business users
responsible for just monitoring batch
and configuring POM to enable
callbacks into the Company's systems.
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Table 3-1 (Cont.) Roles

- _____________________________________________________________________________|
Role Alias Description

BATCH_ADMINISTRATOR_JOB Administrator Users within this role are retailer
administrators with full access to all
POM actions. They monitor, maintain
and configure the batch schedules.
They may also maintain POM
application configurations for efficient
operations. They troubleshoot batch
issues and work with Oracle support
personnel to address those issues.
Finally, they may apply batch schedule
patches and upgrades.

Additionally, users assigned this role
are given access to the Oracle AMS
Utilities screen.

BATCH_VIEWER_JOB Viewer Users within this role are retailer
business users responsible for just
monitoring batch. They have view
access to all POM screens except AMS

Utilities.
BATCH_SCHEDULE_CONFIGURATIO Schedule Config Users within this role are typically
N_MANAGER_JOB Mgr retailer administrators responsible for

just monitoring batch and configuring
external dependencies and callbacks
into the Company's systems. They have
view access to all POM screens except

AMS Utilities.
BATCH_SCHEDULE_ADMINISTRATO Schedule Admin Users within this role are typically
R_JOB retailer administrators responsible for

maintaining monitoring and executing
batch. They have view access to all
POM screens except AMS Utilities. They
can perform select activities on the
Batch Monitor screen to move the
schedule along. They also have update
access to the Batch Administration
screen. They can also configure some
application properties and can
configure a new schedule

BATCH_ORACLE_AMS_ADMINISTRA AMS Admin Users within this role are typically

TOR_]JOB Oracle AMS administrators who
monitor, maintain and configure the
batch schedules. They also maintain
POM application configurations for
efficient operations. They troubleshoot
batch issues and work with other
Oracle development and support
personnel to address those issues.
Finally they apply POM and batch
schedule patches and upgrades.

ORACLE 3-2



Functional Access by Role

This section lists all roles that have update access for each functional aspect of every screen.
It is organized by screen, except for the first two tables.

ORACLE

Table 3-2 External Integration

Chapter 3
Functional Access by Role

Schedule Admin
Administrator

Feature Roles (aliases) with access
Invoking batch execution Monitor
from an external system
Requesting the status of a
batch execution .
AMS Admin

Releasing dependency on an
external process

Table 3-3 POM Task Menu

Feature

Roles (aliases) with access

Show Batch Monitoring task

Show System Configuration task

Show Batch Administration task

Show Scheduler Administration task

Show Schedule Maintenance task

Show AMS Utilities task

Monitor

Business User
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Business User
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
Monitor

Schedule Admin
AMS Admin
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

AMS Admin
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Table 3-4 Screen: Batch Monitoring
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Feature

Buttons for Create Schedule, Close
Schedule and Restart Schedule

Jobs table on Batch Monitoring screen -
Buttons for Run, Rerun, Hold, Release, Skip,
Release Skip, and action for Add Comments

Jobs table Actions menu on Batch
Monitoring screen - Edit Parameters (for
selected job)

Job Details screen - Enable/Disable External
Dependencies

Job Details screen - Retry Schedule Link
button

Job Details screen - Retry Callback button

Execution Engine display Configuration

Download Job Log
Download Cycle Summary

Scheduler Tasks Monitoring and actions

Roles (aliases) with update access

Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin
Monitor
Administrator
AMS Admin
Monitor
Administrator
AMS Admin
Administrator
AMS Admin

All authenticated users
All authenticated users

Monitor
Administrator
Schedule Admin
AMS Admin

Table 3-5 Screen: System Configuration

Feature

Roles (aliases) with update access

System tab - Update actions

Schedule tab - Update actions for general &
environment settings

Schedule tab - Job agent system options
dialog

Administrator
AMS Admin

Administrator
AMS Admin

Administrator
AMS Admin
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Table 3-5 (Cont.) Screen: System Configuration

Feature

Roles (aliases) with update access

Schedule tab - Update actions for MDF
configuration

Schedule tab - Update actions for job agent
throttling configuration

System tab - Update actions for external
configurations

Global Edit - Settings updates

Global Edit - External Configuration
updates

Configure New Schedule

Administrator
AMS Admin

Administrator
AMS Admin

Business User
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
AMS Admin

Business User
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin

Table 3-6 Screen: Batch Administration

Feature

Roles (aliases) with update access

Export Config and Import Config buttons

Enable/disable switch on each of the Recurring

Flows and Jobs within each Flow

Jobs table on main UI - Edit and Enable/Disable

actions

Batch Job Details - Enable/Disable
Dependencies

Batch Job Details - Create/Enable/Disable/
Delete Inter-Schedule Dependencies

Batch Job Details - Create/Enable/Disable/
Delete Schedule links

Administrator
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin
Administrator
AMS Admin
Administrator
AMS Admin
Administrator
AMS Admin
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Table 3-6 (Cont.) Screen: Batch Administration

Feature Roles (aliases) with update access
Batch Job Details - Create/Enable/Disable/ Administrator
Delete External Dependencies Schedule Config Mgr

Schedule Admin

AMS Admin

Table 3-7 Screen: Scheduler Administration

Feature Roles (aliases) with update access
All Functions on the Scheduler Monitor
Administration screen Administrator

Schedule Admin

AMS Admin

Table 3-8 Screen: Schedule Maintenance

Feature Roles (aliases) with update access

All actions: Import Latest Schedule button, Administrator
Upgrade, Retry buttons in table row AMS Admin

Download Configuration and download
POM seed data

Table 3-9 Screen: AMS Utilities

Feature Roles (aliases) with update access
Manual Job Run Administrator
Override Job Status AMS Admin

Override Execution Request Status

Table 3-10 Screen: Application Properties

Feature Roles (aliases) with update access
Application Properties Schedule Admin

Administrator

AMS Admin
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